## TABLE OF CONTENTS

1. **Introduction:**
   - 1.1 Purpose: ................................................................. 1-1
   - 1.2 Timeline: ..................................................................... 1-1
   - 1.3 Format: ...................................................................... 1-1
   - 1.4 Training Expectations: .................................................. 1-2
   - 1.5 Performance appraisals: ............................................... 1-2
   - 1.6 Competency/Proficiency Testing: ............................... 1-2
   - 1.7 Cosigning Reports ..................................................... 1-3
   - 1.8 Required Reading: ...................................................... 1-3

2. **Block I. Laboratory Familiarization**
   - 2.1 Laboratory Orientation .............................................. 2-1
   - 2.2 Safety and Contamination Prevention: ......................... 2-1
   - 2.3 Organization of Examinations: ..................................... 2-2
   - 2.4 Required Reading: ...................................................... 2-2

3. **Block II. Reagent Preparation and Equipment Maintenance**
   - 3.1 Reagent/Solution Preparation and Handling: ............... 3-1
   - 3.2 Equipment: ................................................................ 3-1
   - 3.3 Pipettes: ................................................................... 3-2
   - 3.4 Glassware: ............................................................... 3-2
   - 3.5 Required Reading: ...................................................... 3-3

4. **Block III. Evidence Examination**
   - 4.1 Establishing a link: .................................................... 4-1
   - 4.2 Streamlining: ............................................................ 4-1
   - 4.3 Crime Scene Evidence Collection: ............................ 4-1
   - 4.4 Evidence submission .................................................. 4-2
   - 4.5 Preservation and Storage: .......................................... 4-2
   - 4.6 Multi-section Evidence: ............................................. 4-2
   - 4.7 Evidence Listing: ...................................................... 4-3
   - 4.8 Evidence Examination: ............................ 4-3
   - 4.9 Required Reading: ...................................................... 4-4

5. **Block IV. Blood Detection**
   - 5.1 Leuco Malachite Green (LMG): .................................. 5-1
   - 5.2 Takayama (Hemochromogen): .................................. 5-1
   - 5.3 Ouchterlony Precipitin Test: ...................................... 5-2
   - 5.4 Required Reading: ...................................................... 5-3
   - 5.5 Sample Collection: ................................................... 5-4

6. **Block V. Semen Detection**
   - 6.1 Acid Phosphatase (AP): ............................................ 6-1
   - 6.2 Alternate Light Source: ............................................. 6-1
   - 6.3 PSA (p30) Test: .......................................................... 6-2
   - 6.4 Identification of Intact Sperm Cells: ............................ 6-3
   - 6.5 Required Reading: ...................................................... 6-3

7. **Block VI. DNA Analysis**
   - 7.1 Restriction Fragment Length Polymorphisms (RFLP): .... 7-1
1 Introduction:

The DNA Training Manual provides a guideline for the training of Criminalists and Technicians assigned to the MSHP DNA Section. Training can not encompass all aspects of analyzing evidentiary items, but should provide a foundation from which an individual can draw upon and make appropriate decisions with case work.

1.1 Purpose:

1.1.1 To help the trainee develop good laboratory practices in the performance of analytical procedures.

1.1.2 To help the trainee learn the proper procedures for evidence handling and storage. Emphasis will be placed on the importance of the chain of custody.

1.1.3 To help the trainee achieve proficiency and understanding of the detection, identification, and comparison of biological specimens.

1.1.4 To prepare the trainee for court testimony of casework results and conclusions.

1.1.5 To provide the trainee with sources of reference material covering all aspects of duties and responsibilities of the Technician/Criminalist, i.e. analysis, court testimony, quality control, safety, etc.

1.2 Timeline:

1.2.1 Blocks I-V and VII of training are designed to encompass approximately six months, though this may vary with the individual. DNA Training, Block VI, should take at least six months on its own.

1.2.2 The Criminalist/Technician will be given oral/written examinations to demonstrate their knowledge of the information covered prior to starting another area.

1.3 Format:

1.3.1 The Technician will be trained in Blocks I-IV and VII. The Criminalist will be trained in all blocks.

1.3.2 The Criminalist/Technician will be provided with reading materials, personal instruction, written/oral examinations and repetitive performance of each task.

1.3.3 The trainee will be provided with a checklist of the required knowledge for each block.
1.3.4 The trainee will participate in moot courts for stain identification and DNA analysis.

1.4 **Training Expectations:**

The following criteria must be met for advancement to permanent full time employment. They are such that inadequate performance of any one of these components is unacceptable for the position as a whole.

1.4.1 Demonstrate knowledge and understanding of analyses.

1.4.2 Demonstrate the ability to make reasonable decisions.

1.4.3 Demonstrate the ability to interpret results and troubleshoot problems.

1.4.4 Maintain accurate and concise notes and records.

1.4.5 Possess clear, concise verbal and written communication skills.

1.4.6 Demonstrate neat and proficient laboratory technique.

1.4.7 Obtain correct results on competency tests.

1.4.8 Pass the oral/written exams.

1.4.9 Perform acceptably in the moot courts.

1.5 **Performance appraisals:**

1.5.1 Informal written or verbal appraisals by the DNA Supervisor for trainees will be made:

1.5.1.1 At the end of each month of the probationary period.

1.5.1.2 At any time the employee’s performance substantially changes.

1.5.2 Formal written appraisals by the DNA Supervisor for all Criminalists/Technician will be made as follows:

1.5.2.1 At the end of months 2, 4, and 6 of the probationary period.

1.5.2.2 Annually after probationary period.

1.5.2.3 At anytime the employee’s performance substantially changes.

1.6 **Competency/Proficiency Testing:**

1.6.1 Personnel Tested:
All Criminalists/Technicians will be tested. A trainee will be expected to successfully complete a Competency test before beginning casework independently. A competency test will also be administered for each new method adopted. After completing training, the trainee will be routinely proficiency tested according to the schedule outlined in section 2.

1.6.2 Frequency of Testing:

1.6.2.1 Technician:

The Technician will be required to successfully complete one Stain Identification proficiency test each year. This test will be designed to emulate casework. The Technician will complete all documentation and preliminary testing and sample collection required of the position.

1.6.2.2 Criminalists:

Criminalists will be required to successfully complete one Stain Identification proficiency test each year. This test will be designed to emulate casework. Criminalists will complete all documentation, preliminary and confirmatory testing and sample collection. Criminalists will generate a report of results. This proficiency may be combined with a DNA analysis proficiency.

Criminalists will also be required to successfully complete two DNA proficiency tests each year. Criminalists will complete all documentation and analyses required of DNA testing. Criminalists will generate a report of results.

1.6.3 Extended Leave of Absence:

A proficiency (or requalifying) examination will be given to an individual after an extended leave of absence, such as maternity leave.

1.6.4 Evaluation of Testing:

The Competency/Proficiency exams will be evaluated by the DNA Section Supervisor or designee.

1.6.5 Discrepancies:

Refer to the Laboratory QA/QC Manual

1.7 Cosigning Reports

Upon successful completion of training and the competency test for stain identification and DNA analysis, all reports will be technically and administratively reviewed by a senior qualified Criminalist, who will cosign the reports for a period of three months or twenty cases, which ever comes first.

1.8 Required Reading:

ASCLD-LAB Manual, Sections 1.4.3, and 2.5

Quality Assurance Standards for Forensic DNA Labs, Sections 5, and 13
2 Block I. Laboratory Familiarization

2.1 Laboratory Orientation

The trainee must become familiar with the physical layout of the MSHP General Headquarters, security procedures, and organizational structure of the laboratory. Familiarization should include at a minimum:

Layout of MSHP GHQ complex and Laboratory building;
Organizational structure of the Highway Patrol and Laboratory System;
Goals and Objectives of the Highway Patrol and Laboratory;
The various sections of the laboratory and their personnel including LRECC, Firearms, Documents, Prints, DNA, DNA Profiling, Trace Evidence, Drug Chemistry, Toxicology;
Administrative positions in the lab including Director, Asst. Director, QA Coordinator, Safety Officer, DNA Technical Leader, CODIS Administrator, and immediate Supervisor;
Forensic organizations including ASCLD, DAB, SWGDAM, MAFS, AAFS.

2.2 Safety and Contamination Prevention:

It is the responsibility of each laboratory member to operate in a safe manner and work for the prevention of contamination. Familiarization with the laboratory safety procedures is required of all new employees prior to initiation of training.

2.2.1 Lab coats are available for use when working with evidence, physiological fluids or caustic chemicals/solutions. Coats should be laundered on a regular basis or when soiled.

2.2.2 Disposable gloves should be worn at all times when working with evidence, physiological fluids or caustic chemicals. Gloves should be changed and discarded after obvious contamination or soiling, when handling different items of evidence, and before leaving the amplification area.

DNases, and bacteria are ubiquitous on the skin. To avoid introducing these into DNA-containing solutions, gloves should also be worn whenever handling tubes, equipment, reagents, and solutions. Avoid touching person or office equipment, such as phones and computers, with gloves.

2.2.3 Protective eyewear or shields should be used when working with liquid blood and chemicals/solutions.
2.2.4 Face masks should be used when working with evidence that has a high potential of becoming airborne, finely powdered dried blood, and respiratory irritating chemicals.

2.2.5 All evidence examination should be performed over bench paper, which is changed after each specimen. Specimens associated with the Victim should be examined in an area separate from that of specimens associated with the Suspect. Cuttings and extracts should be examined over bench paper or a previously decontaminated area, such as in a laminar hood.

2.2.6 Do not “blow out” samples with a pipet. This may cause aerosols.

2.2.7 Chemical or biological fluid spills must be cleaned immediately.

2.2.8 Decontamination of DNA hoods and equipment in the hood is conducted before and after sample preparation. Decontamination may be conducted with UV radiation or a 0.5% bleach solution followed by distilled water wash.

2.2.9 All hoods, centrifuges, pipettes and the amplification room should be decontaminated on a regular schedule.

2.2.10 All common work areas should remain uncluttered and clean. Any equipment used during analysis should be cleaned and stored immediately after use.

2.2.11 Restock all supplies after use.

2.2.12 Read appropriate Material Safety Data Sheets (MSDS) prior to working with a chemical.

2.3 Organization of Examinations:

All items of evidence are examined in the order, which minimizes the loss or damage of evidence pertaining to other disciplines. Criminalists/Technician should frequently coordinate with other sections to ensure the best evidence handling possible is performed. Refer to the Laboratory Operations Manual.

2.4 Required Reading:

Lab Operations Manual, Tabs D and H
Laboratory QA/QC Manual, sections 1, 5, 16, 17, and 18
Laboratory Safety Manual
ASCLD-LAB Manual, Section 1.3.3, 3.3, and 3.4.
3 Block II. Reagent Preparation and Equipment Maintenance

3.1 Reagent/Solution Preparation and Handling:

Note: The Material Safety Data Sheets (MSDS) are available in the MSDS Information Center near the chemical storage room (271). They will provide general information on toxicity, storage requirements, disposal, etc. All employees should be familiar with the hazards of the chemicals they use.

3.1.1 Defined:

3.1.1.1 Stock Chemicals are defined as dry or liquid reagents that are purchased from a vendor and used in analyses.

3.1.1.2 Solutions/Reagents are defined as the combination of chemical(s) with/or without a solvent that are used for analyses.

3.1.1.3 Water used to prepare all solutions is distilled and deionized. Rinse water for glassware and equipment should be distilled.

3.1.2 Storage:

Chemicals should be stored according to the manufacturer’s recommendations. The date of receipt should be noted on the packaging. Date received, lot number and expiration date is logged into the Supply Log Book.

3.1.3 Expiration Dates:

3.1.3.1 Stock Chemicals:

3.1.3.1.1 Primarily, the manufacturer's expiration date will be honored.

3.1.3.1.2 Stock chemicals without a manufacturer’s expiration date will be assigned a five year expiration.

3.1.3.1.3 Solutions/Reagents:

If any manipulation of the purchased chemical occurred at the lab, i.e. dilution or combination with other chemicals, a one year maximum expiration date will be assigned or the earliest expiration date of the ingredients of that solution.

Note: Some solutions will require a shorter expiration period and should be labeled as such.
3.1.4 Disposal:
Reagents should be disposed of in a safe manner in accordance with good laboratory practice, the MSDS and the law.

3.1.5 Handling:
All necessary precautions should be taken that are appropriate for the chemical/solutions in use.

3.1.6 Preparation:
3.1.6.1 Solutions/reagents will be prepared and stored in accordance with the manufacturer’s recommendations or the DNA Section Solution/Reagent Manual.

3.1.6.2 The preparation of a stock solution should be documented in the Solution Log as to date prepared, individual who prepared the solution, lot numbers and expiration date. Reagent and solution containers should be clearly marked as to contents, date prepared, individual who prepared the solution, expiration date and storage conditions.

3.1.7 Usage:
A volume of solution proportional to the need of the moment should be aliquoted into a clean secondary container. The container should be marked with the preparation date of the stock solution.

Note: If individual aliquoting is not possible, such as with phenol/chloroform/isoamyl alcohol the pipet tip should be changed with each withdrawal. Excess solution **may not** be returned to the original container.

3.2 Equipment:
3.2.1 Each user is responsible for confirming that the equipment is working appropriately, documenting any information required and leaving the equipment clean and in proper condition. In the event of a malfunction, the user is responsible for alerting the supervisor. The malfunction and its eventual correction must be documented in the Equipment Log.

3.2.2 Routine monitoring and calibration is required of most equipment. Results will be documented in the Equipment Log. The schedule and procedures for calibration checks are provided in the Equipment Log and DNA Technician Procedure Manual.

3.3 Pipettes:
3.3.1 Dedicated pipettes for DNA analysis are assigned to each Criminalist and a set for each laminar flow hood in the amplification area.
3.3.2 Verification of the pipet calibration with an allowable 5% inaccuracy should be conducted annually. Only calibrated pipettes should be used to measure solution volumes where quantitative precision is necessary.

3.3.3 Uncalibrated pipettes may be used to transfer amounts of solutions when accuracy is not essential, such as with Ouchterlony plates and Takayama slides.

3.3.4 Decontamination of pipettes is performed regularly.

3.4 Glassware:

3.4.1 Containers used to prepare reagents and solutions should be rinsed well with distilled water and inverted to dry.

3.4.2 Containers in which solutions have dried or which contain sediment or films must be washed with a detergent and rinsed thoroughly with distilled water prior to use.

3.4.3 New glassware should be washed and rinsed well prior to use.

3.5 Required Reading:

Laboratory QA/QC Manual, sections 13, 14, and 15
DNA Evidence Technician Manual
ASCLD-LAB Manual, sections 1.4.2.8 to 1.4.2.13 and associated discussion
Quality Assurance Standards for Forensic DNA Laboratories, standards 9.2, 16.1
4 Block III. Evidence Examination

Note: Evidence examination by a Trainee will be conducted under the supervision of a qualified Criminalist/Technician.

Clean, disposable latex or vinyl gloves should be worn when collecting or handling biological evidence. Gloves should be changed frequently.

4.1 Establishing a link:

The ultimate goal of evidence examination is to determine if a physical link exists between the perpetrator and the victim or the individuals involved to a crime scene. Evidence should be evaluated to see how, if at all, the strongest link may be established. For instance, in a sexual assault case the most informative link is DNA comparison of semen detected on the vaginal samples of the victim. This comparison provides a direct link between the victim and the perpetrator. If no semen is detected on the vaginal swabs, the next closest link is the victim’s clothing and then the bedding. Each successive step provides a weaker level of association between the individuals involved in a crime.

4.2 Streamlining:

Once a strong physical link is established, the benefit of additional lab exams can be questioned. For example, after establishing a link with the vaginal samples, detecting semen on the under pants or bed sheets and the subsequent DNA comparisons of these items is not necessarily helpful or an efficient use of resources. Under these conditions additional examinations should not be performed. Exceptions to this policy would include situations where the sample may be degraded or weak and/or more than one suspect may be involved. Then the additional examinations are warranted.

4.2.1 Samples that have no obvious evidentiary value will not be examined.

4.2.2 Once a strong physical link is established by one section in a multi-section case, examinations in other sections may not improve the association and should be evaluated closely. An example is the examinations performed by the DNA and Trace sections. Semen detection and hair examinations are routine requests in sexual assault cases. If a physical link can be established by DNA, the time and effort necessary to conduct hair exams is unnecessary since the outcome will not add any further information to the investigation. Eliminating these exams allows the Trace section to concentrate on other cases where analyses may be of more value.

4.3 Crime Scene Evidence Collection:

4.3.1 Samples from nonporous material may be collected by swabbing or scraping. Biological fluids and tissues should be air dried and packaged in a paper container which is then sealed, initialed and dated.
4.3.2 Samples from porous materials may be cut. Package sample in a paper container which is then sealed, initialed and dated.

4.3.3 Blood standards should be collected in an EDTA tube. Buccal cell standards may be collected with sterile cotton swabs or Omni swabs.

4.3.4 Sharp evidence should be packaged in a protective container, such as a cardboard or plastic, which is then sealed, initialed and dated.

4.4 Evidence submission
At a designated time convenient for both sections the trainee will spend a day assisting the LRECCs accepting and returning evidence at the front counter. In addition other duties of the LRECC will be observed. A checklist will be used to ensure coverage of all applicable duties.

4.5 Preservation and Storage:

4.5.1 Prior to examination blood standards and sexual assault kits should be stored in a refrigerator.

4.5.2 Biological evidence, not assigned to Prints, should be stored frozen if wet, containing fresh biological tissue or prone to degradation. If stains are properly air dried before submission, evidence can be stored at room temperature.

4.6 Multi-section Evidence:
Prior to examining a specimen, the Criminalists/Technician should determine if the item needs to be examined by any other section, i.e. Prints and Trace, and if DNA exams may interfere with those exams of another section. If there is any doubt that removing a sample would destroy another section’s testing, that section should be contacted. If something is detected that may be of significance to another section, that section should be contacted. Refer to Laboratory Operations Manual

4.6.1 Prints:

4.6.1.1 If possible, testing and sample collection should be conducted prior to print processing.

4.6.2 Firearms/toolmarks:

4.6.2.1 A Criminalist/Technician should not scrape or scratch a tool or weapon that will be used for tool mark/firearm comparisons.

4.6.2.2 If Firearms is assigned to a weapon or tool, all or most of the sample should be removed. Some sample should be saved in the original container for confirmation testing by another agency.

4.6.3 Trace:
4.6.3.1 Hairs/fibers that may be lost during examination should be removed and placed in a container for Trace.

4.6.3.2 Specimens assigned to Trace should be securely wrapped in the paper on which they were examined to prevent loss of trace evidence.

4.6.4 Toxicology:

4.6.4.1 If a blood standard is meant to be shared by Toxicology and sufficient sample may not have been provided, contact Toxicology.

4.7 Evidence Listing:

Evidence listing will be accomplished in accordance with the Laboratory Operations Manual.

4.7.1 All outside containers will have the Laboratory case file number and specimen number.

4.7.2 The initials of the Criminalist/Technician and the date opened will be annotated on the package.

4.7.3 Containers will be opened, if possible, in a location that does not break the submitting agency’s seal.

4.7.4 All specimens, if possible, will contain the case file number, specimen number and initials.

4.7.5 The notes of the Criminalist/Technician should contain a detailed description that would discriminate one specimen from another.

4.8 Evidence Examination:

4.8.1 To prevent cross contamination of trace material evidence associated with the Victim should be examined in a separate area from the evidence associated with the Suspect.

4.8.2 Each specimen should be opened and processed separately.

4.8.3 Scissors, forceps, gloves and other equipment used to manipulate evidence should be cleaned or discarded between samples.

4.8.4 Clean paper will cover the examination table.
4.9 **Required Reading:**

- Forensic Evidence Handbook, section III. 5.
- ASCLD-LAB Manual, section 1.4.1
- Quality Assurance Standards for Forensic DNA Laboratories, section 7
- Laboratory QA/QC Manual, sections 6 and 7
- Laboratory Operations Manual, tabs E, F, J, K, and L
5 Block IV. Blood Detection

5.1 Leuco Malachite Green (LMG)

5.1.1 Background:
The LMG test is used as a presumptive test for blood. Ionic iron forms chelate (ring) structures with many organic compounds and often iron-chelates possess catalytic activity in oxidation reactions. An example of such a biological catalyst is peroxidase which decomposes hydrogen peroxide to form free hydroxyl radicals:
$$H_2O_2 + \text{Peroxidase} \rightarrow 2(\text{HO}^-)$$
The heme group of hemoglobin (Hb) possesses a peroxidase-like activity, which may catalyze the breakdown of hydrogen peroxide. In the presence of LMG, Hb catalyzes the oxidation of its colorless form into the blue green oxidized state. If no other organic oxidizable compound, such as LMG, is present these radicals decompose to form water and oxygen.

Leuco Malachite Green + Hb $\rightarrow$ Oxidized Malachite Green
(colorless) $\rightarrow$ (blue green)

5.1.2 Quality Assurance:
Chemical: Newly made reagent should be tested with a known blood standard (positive) and a clean piece of filter paper (negative) prior to use. The reagent must perform appropriately for use on casework samples.

5.1.3 Procedure: Refer to DNA Section Procedures Manual

5.1.4 Interpretation:
A positive test for LMG is the formation of a blue green color within ten seconds. The positive result is not a confirmation of the presence of blood.

5.1.5 If a sufficient amount of sample is not present for confirmation tests to be performed, the sample may be used for DNA analysis without these tests. Otherwise, confirmation exams should be performed.

5.1.6 Report Conclusion Example:
A potential blood stain was detected on the glass; due to the limited amount of sample, the presence of blood could not be confirmed.

5.2 Takayama (Hemochromogen):

5.2.1 Background:
Providing a sufficient amount of sample is available and the information is valuable to the investigation, the Takayama test should be performed. Takayama is a crystal test used for the confirmation of the presence of blood on samples that screened positive with LMG. Hemochromogens are compounds of
ferro protoporphyrin in which the residual valences of a heme complex are occupied by nitrogenous bases such as pyridine.

5.2.2 Quality Assurance/Quality Control:

5.2.2.1 Reagent: Slides containing Known Human Blood (KHB - positive) and water (negative) are required with each group of samples. The controls must work appropriately for the case work results to be acceptable.

5.2.2.2 Second Review: A qualified Criminalist will confirm the results of the controls and samples and initial the worksheet.

5.2.3 Procedure: See DNA Procedure Manual

5.2.4 Interpretation:

A positive result is indicated by the presence of salmon colored, feather shaped crystals. Crystals formed from weak samples may not display the extensive feathering characteristic.

5.2.5 Report Conclusion Examples:

If only Takayama was performed and results were negative:
No blood was detected on the shirt.

If only Takayama was performed and results were positive:
Blood was detected on the shirt.

If Takayama and Ouchterlony were both positive:
(See next section for Ouchterlony Precipitin Test)
Human blood was detected on the shirt.

If Takayama is positive and Ouchterlony is negative:
Blood not of human origin was detected on the shirt.

5.3 Ouchterlony Precipitin Test:

5.3.1 Background:

It may be necessary to determine if the body fluid is of human (or higher primate) origin. In the Ouchterlony or Precipitin test soluble antigens from the sample react with antibodies in a gel medium. Antigen-antibody complexes will form and increase to a size at which point they are no longer soluble and precipitate out forming a visible white line in the gel medium.

Note: The RT-PCR quantification system which is higher primate specific may be used in lieu of the Ouchterlony test when sample is limited.

5.3.2 Quality Assurance:

5.3.2.1 Reagents:
Wells containing KHB (positive) and water (negative) are required with each group of samples. The controls must work appropriately for the results of case samples to be acceptable.

5.3.2.2 Second Review:

A qualified Criminalist will confirm the results of the controls and samples and initial the worksheet.

5.3.3 Procedure: See DNA Section Procedure Manual

5.3.4 Interpretation:

A white line between the sample well and the $\alpha$-human well indicates the presence of human proteins.

Note: The $\alpha$-human antibody will cross react with higher primates.

5.3.5 Report Conclusion Examples:

If Ouchterlony only, was positive:

*Human proteins were detected on the shirt.*

If Takayama and Ouchterlony were positive:

*Human blood was detected on the shirt.*

If Takayama is positive and Oucherlony is negative:

*Blood not of human origin was detected on the shirt.*

5.4 Required Reading:


Laboratory QAQC Manual, sections 8, 9, 10, 11, 12, and 19

5.5 Sample Collection:

5.5.1 Only the amount sufficient for testing should be collected. Return all unused cuttings/swabs to the submitting agency.

5.5.2 Cuttings/swabs should be dried and placed in individual, labeled tubes.

5.5.3 A portion of the blood standard should be dried on filter paper and/or FTA paper for preservation.
6 Block V. Semen Detection:

6.1 Acid Phosphatase (AP)

6.1.1 Background:
Acid phosphatase is found in high levels in semen and originates from the epithelial cells of the prostate. Acid phosphatase (AP) reagent is an enzymatic presumptive test used to indicate the possible presence of semen. Acid phosphatase cleaves the phosphate from $\alpha$-naphthyl phosphate and the phosphate binds with Brentamine Fast Blue B to yield a purple azo-dye.

6.1.2 Quality Assurance/Quality Control:
The reagent should be tested with a known semen standard (positive) and a clean piece of filter paper (negative) prior to use. The reagent must perform appropriately for use on casework samples.

6.1.3 Procedure: See DNA Section Procedure Manual

6.1.4 Interpretation:
If a dark purple color develops within 1-2 minutes, the reaction is considered positive. A positive test is not confirmation of the presence of semen.

6.1.5 Report Conclusion Examples:
Analyses will not normally stop at this point.

6.2 Alternate Light Source:

6.2.1 Background:
The Alternate Light Source may be used to screen large items of evidence that may contain biological fluids. The shorter wavelengths, approximately 390-540 nm, will cause the excitation of molecules in body fluids, excluding blood, and the subsequent emission of photons (fluorescence) during the excitation of the stained area. The orange goggles assist in improving contrast by blocking some of the other wavelengths. Some fabrics, however, will quench the fluorescence. The crotch of underpants, pants, etc, should be tested with AP Spray even in the absence of a fluorescent stain.

Note: Many cosmetics, detergents and food substances will also cause fluorescence.

6.2.2 Quality Assurance/Quality Control:
A known semen stain (positive) and a clean piece of filter paper (negative) are viewed to determine, if the light is working appropriately. Equipment failure should be reported to the section supervisor immediately.

6.2.3 Procedure: See DNA Section Procedure manual
6.2.4 Interpretation:
The blue-white fluorescence of a stain is a possible indication of the presence of a body fluid, excluding blood, and should be tested further.

6.3 PSA (p30) Test:

6.3.1 Background:
The ABAcard test currently used at the MSHP lab detects the presence of semen on samples that screened positive for AP. p30 is a protein that is produced in the prostate. Its detection in this system is based upon a twofold reaction. The first reaction is the joining of a mobile monoclonal antibody (MAB)/dye molecule that is specific for p30 with a p30 molecule that may be in the sample. The second reaction is a joining of the MAB-p30 antigen complex to a polyclonal antibody molecule that is already attached to the test area (T). A pink colored band develops as the dye/MAB/p30 molecules adhere to the polyclonal antibodies and accumulate in the test area. The test also contains an inherent control that acts in a similar manner, however the free MAB/dye molecules attach to anti-immunoglobulin antibodies that are specific for the MAB, which are fixed in the control area (C).

Note: p30 may be detected in liquid urine of males and females.

6.3.2 Quality Assurance/Quality Control:

6.3.2.1 Chemical:
Each new lot of ABAcard kits is tested. A 4ng PSA sample (commercially available), female vaginal swab (~1/8 swab), and DDI water will be tested. Times and results will be documented. Proper results must be obtained to use kits on casework samples.

6.3.2.2 Second Review:
A qualified Criminalist will confirm results and initial paperwork.

6.3.2.3 Procedure: See DNA Procedure Manual

6.3.2.4 Interpretation:
The presence of p30 is concluded by the production of a band at the test site and a band at the control site.

6.3.2.5 Report Conclusion Example:
p30 was detected:
*p30, a protein found in high concentrations in semen, was detected on the underpants.*

p30 was not detected:
*Semen was not detected on the underpants.*
6.4 Identification of Intact Sperm Cells:

6.4.1 Background:
The sexual assault kits may contain vaginal, rectal or oral smears, which can be screened for intact sperm cells if the corresponding swabs are negative or not provided. The slides are viewed using a microscope and either 20x or 40x lens.

6.4.2 Quality Assurance/Quality Control:
Second Review: The presence of an intact sperm cell(s) will be confirmed by a qualified Criminalist/Technician, who will initial the worksheet.

6.4.3 Procedure: See DNA Procedure Manual

6.4.4 Interpretation:
An intact sperm cell is identified by the presence of a head, neck and tail.

6.4.5 Report Conclusion Examples:
Sperm cells were detected: 
*Intact sperm cells were detected on the vaginal smears.*
Sperm cells were not detected: 
*Sperm cells were not detected on the vaginal smears.*

6.5 Required Reading:
Gaensslen, R.E., *Sourcebook in Forensic Serology, Immunology and Biochemistry*, National Institute of Justice, 1983, sections 10.3.1 to 10.3.5.
ABACard p30 Test Instructions


## Block VI. DNA Analysis

### Background Information:

#### 7.1 Restriction Fragment Length Polymorphisms (RFLP)

RFLP analysis uses areas of the human genome that display sequences of nucleotides repeated over and over. The number of repeats may differ between individuals and these VNTR (Variable Number Tandem Repeats) can be used for identification. During the procedure DNA is cut into fragments of varying lengths by a restriction enzyme. The fragments are arranged by size using gel electrophoresis. Once transferred from the gel onto a permanent nylon membrane, desired areas of the DNA are probed with radioactive or chemiluminescent tagged DNA fragments specifically designed to bind to the polymorphic regions of interest. Bands are visualized by exposure and development of sensitive X-ray film. Computer software determines approximate fragment size by comparison to the size markers or ladders bracketing the sample lane.

#### 7.2 DQA1/Polymarker

DQA1/PM is a polymerase chain reaction (PCR) based procedure that utilizes sequence specific characteristics in six specific areas of the genome to differentiate between individuals. These six areas are amplified and then visualized using a reverse dot blot method with probes attached to nylon strips. Visualization of the polymorphisms is achieved by an enzyme linked color reaction, resulting in the formation of blue dots on the probe strip.

#### 7.3 Amplified Fragment Length Polymorphism (AmpFLP) D1S80

Similar to RFLP, D1S80 is an area of the genome that contains fragment length polymorphisms. The repeat units for D1S80 are much shorter than the repeat units for RFLP loci and therefore can be amplified using the PCR. Fragment lengths are sorted through gel electrophoresis and visualization of the resulting bands are achieved by subjecting the gel to silver staining. Allele calls are made by visual comparison with an allelic ladder run in one of the lanes.

#### 7.4 Short Tandem Repeats (STR):

Short Tandem Repeats are fragment length polymorphisms that are small enough to be successfully amplified using the PCR. These amplified fragments are sorted using slab or capillary electrophoresis. Visualization is achieved by means of laser excited fluorescent tags associated with the PCR product. Allele calls are made by computer software comparison with an allelic ladder.
STRs are composed of repeat sequences of 2-10 base pairs.

‘Simple’ repeats contain units of identical length and sequence, ‘compound’ repeats are comprised of two or more adjacent simple repeats, ‘complex’ repeats may contain several repeat blocks of variable unit length, along with more or less variable intervening sequences.

**Examples:**

Simple: TH01  (TCAT)\textsubscript{5-11}

Compound: vWA  (TCTA)(TCTG)\textsubscript{3-4}(TCTA)\textsubscript{8,10-17}

Complex: D21S11  ((TCTA)\textsubscript{4-6}(TCTG))\textsubscript{5-6}(TCTA)\textsubscript{3}TA(TCTA)\textsubscript{3}TCA(TCTA)\textsubscript{2}TCCATA(TCTA)\textsubscript{8-16}---TC

### 7.5 Mitochondrial DNA (MtDNA)

The main difference between MtDNA analysis and the other DNA analyses previously mentioned is the source of DNA. MtDNA uses the circular DNA of cellular mitochondria, tiny organelles found in cellular cytoplasm, instead of nuclear DNA. Because of this the inheritance patterns of MtDNA are totally different than nuclear DNA. Analysis is performed by sequencing the two hyper variable regions in the non-coding area of the genome. Visualization of point differences in these regions is usually achieved by automated sequencing instruments using fluorescent detection systems.

### 7.6 Required Reading:


### Laboratory Layout:

#### 7.7 Contamination Prevention:

The sensitivity of the Polymerase Chain Reaction (PCR), which permits amplification of minute quantities of DNA, necessitates extreme precautions to avoid contamination of samples yet to be amplified.

The following are potential sources of contamination:
**Type A Contamination:** Sample contamination with exogenous human genomic DNA from the environment.

Because of the specificity of the PCR amplification, contamination of samples with non-primate DNA should not affect results since a full profile would not be obtained. Care should be taken, however, to prevent chance contamination by human DNA. Gloves should be worn at all times and changed frequently. Lab workers who are coughing or sneezing should wear masks. Sample tubes should be closed when not in use. Limit aerosols by careful pipetting.

**Type B Contamination:** Contamination between samples during sample preparation.

Extra precautions should be taken during DNA extraction and PCR setup to prevent transfer of DNA from one sample to another. Use a fresh pipette tip for each sample, open tubes carefully, and all tubes should be closed when not in use.

**Type C Contamination:** Contamination of a sample with amplified DNA from a previous PCR reaction, referred to as "PCR product carry-over".

Carry-over contamination occurs when amplified DNA contaminates a sample which has not yet been amplified. It is important to contain amplified PCR product in the designated area to prevent it from ever coming in contact with samples before they are amplified. Carry-over is a concern because an amplification product serves as an ideal substrate for subsequent amplifications.

To minimize the potential for carry-over contamination, the Amplification area is physically isolated from the work areas for DNA extraction and PCR Setup.

Strict physical isolation should be maintained between the area designated for handling amplified DNA and the other areas in order to avoid transfer of amplified DNA out of the designated work area. Amplified DNA or equipment and supplies used to handle amplified DNA should not be taken out of the designated work area without decontamination.

**Equipment and work areas must be decontaminated before and after each extraction or setup.**

### 7.8 DNA Extraction and Amplification Setup Area:

This work area is used only for Extraction and Isolation of DNA and PCR setup. Decontamination must be accomplished before and after extraction and PCR setup. It is the job of each Criminalist/Technician to ensure that decontamination steps and all necessary precautions are taken.

**7.8.1 Dedicated equipment and supplies:**

*7.8.1.1 Each Criminalist has assigned pipettes and a working stock of reagents.*
7.8.1.2 Use disposable gloves at all times and change them frequently. Be conscious of not touching your person, such as the face, or items, such as telephones and refrigerators with potentially contaminated gloves.

7.8.1.3 Use only disposable aerosol resistant pipet tips. Change pipet tips between sample tubes when working with DNA or DNA containing solutions.

7.8.1.4 Avoid touching the inside surface of the tubes with gloves or the pipet shaft.

7.8.2 Special Precautions:

7.8.2.1 Setup for DNA extraction and PCR setup of crime scene samples should be performed at a separate time from the DNA extraction and PCR setup of standards. This precaution will help minimize the potential for cross-contamination between evidence samples and reference samples.

7.8.2.2 Keep all tubes that are not involved with the present transfer closed.

7.8.2.3 Store reagents in small aliquots to minimize the number of times a given tube of reagent is opened. Each Criminalist will maintain their own set of working stock reagents.

7.8.2.4 Centrifuge all tubes prior to opening.

7.8.2.5 Limit the quantity of samples handled in a single run to a manageable number. This precaution will reduce the risk of sample mix-up and the potential for sample-to-sample contamination.

7.8.2.6 Extracted DNA should be stored frozen until it can be analyzed. Extracted DNA that has been analyzed and deemed unnecessary to be maintained should be disposed of in a biohazard bag.

7.8.2.7 Always add the DNA sample to a liquid. This will help prevent the DNA aerosol. Extra care must be taken with the FTA extraction in which the DNA is bound to a punch and the reagents are added to the punch.

7.8.2.8 All unused cuttings must be returned to the submitting agency after completion of analysis. If all the original sample was consumed during testing, the remaining extracted DNA, if any, must be returned to the agency.
Amplified DNA or equipment and supplies used to handle amplified DNA should not be taken out of amplification area without decontamination.

7.9 DNA Amplification Work Area:

7.9.1 Dedicated equipment and supplies:

7.9.1.1 All equipment and supplies that are necessary for the preparation of amplified DNA for 310 capillary electrophoresis are maintained in the amplification area. These items are not removed from this room without decontamination.

7.9.1.2 Always use aerosol resistant pipet tips.

7.9.1.3 Decontaminate the hoods and equipment before and after use.

7.9.2 Special Precautions:

7.9.2.1 Always remove gloves when leaving the amplification area to avoid the transfer of amplified DNA to other work areas.

7.9.2.2 Centrifuge all tubes prior to opening.

7.9.2.3 Store tubes of amplified DNA in the amplification work area only.

7.9.2.4 Amplified product should only be maintained until the analysis is complete. Subsequent to the completion of the case, the amplified product should be destroyed by autoclaving.

7.10 Required reading:

Quality Assurance Standards for Forensic DNA Laboratories, section 6.
Laboratory QA/QC Manual, section 16.
ASCLD-LAB Manual, sections 3.1, 3.2.

STR Analysis:

7.11 Extraction:

The extraction procedure is designed to lyse the cells to release the DNA and purifying the DNA sample for subsequent restriction or amplification.

7.11.1 Types:

7.11.1.1 Phenol/Chloroform/Isoamyl Alcohol (PCI):

*Warning:* Phenol is corrosive. Chloroform is a carcinogen and is toxic by inhalation, absorption and ingestion. See MSDS.
Organic extraction followed by Microcon filtration allows for the separation and purification of DNA from a sample.

7.11.1.2 DNA IQ

The DNA IQ System is a DNA isolation system that binds the DNA to paramagnetic particles to isolate clean DNA and reduce the presence of inhibitors in the sample.

7.11.2 Procedure: Refer to the DNA Section Procedures Manual

7.11.3 Quality Assurance/Quality Control:

Controls are used to measure the quality of the reagents and system. Controls are used to test each step of the DNA analysis procedure.

7.11.3.1 Reagent Blank:

The reagent blank demonstrates that no exogenous DNA is present in the extraction reagents. A reagent blank must be used with each PCI extraction. The quality of the reagent blank is measured at quantification.

7.11.3.2 FTA Blank:

FTA blank demonstrates that contamination has not occurred from the Harris punch, the paper or the extraction reagents. A blank punch must be used with each FTA extraction. The quality of the FTA blank is measured through amplification and CE analysis.

7.11.3.3 Interpretation:

No interpretation is performed at this step.

7.11.3.4 Report Conclusion Examples:

No conclusions are made at this step.

7.12 Required Reading:

DNA Section Procedure Manual.


7.13 Quantification

**Principle:**

To conduct an internal validation of the ABI Prism® 7500 Sequence detection system using the Applied Biosystems Quantifiler™ Human DNA quantitation kit. To develop a QA/QC of the system and a set of procedures for use of the kit components and instrument.

**RT-PCR Overview**

Applied Biosystem’s TaqMan® assay is one of the many assays that have been developed for RT-PCR. The TaqMan assay involves the TaqMan probe annealing specifically to a complimentary region between the forward and reverse primers during the annealing phase of PCR. The TaqMan probe has a fluorescent molecule (or reporter dye), usually FAM™, attached to the 5’ end (©) and a quencher molecule, usually TAMARA™ attached to its 3’ end (©). The proximity of the quencher to the reporter dye inhibits the emitted fluorescence through a process known as fluorescence resonance energy transfer, specifically Forster-type energy transfer (Figure 1). TaqMan probes used in the Applied Biosystem’s Quantifiler™ kit also incorporate an additional chemical modification at the 3’ end known as a minor groove binder (MGB) (©). The minor groove binder (MGB) increases the melting temperature ($T_m$) and thereby allows for the use of shorter, more sequence specific probes. As the DNA polymerase synthesizes new DNA off of the PCR primer, the AmpliTaq Gold® encounters the TaqMan probe and hydrolyzes it with its 5’ nuclease activity. The 5’ nuclease activity of the AmpliTaq Gold causes the reporter fluorophore to be cleaved from the probe and separated from the quencher allowing it to fluoresce. Consequently, with each PCR cycle, the amount of free fluorophore increases yielding fluorescence directly proportional to the cycle number and the amount of input DNA. At 100% PCR efficiency, there is a two fold increase of DNA for every single increase in cycle number. In time, the fluorescent signal accumulates to a point where it can be detected over background. At a certain number of cycles the fluorescence exceeds the threshold cycle or $Ct$. 
The Ct is defined as the PCR cycle where the increase in reporter fluorescence above baseline can first be detected (normally 10 times standard deviation). The default baseline normally occurs between cycles 3 and 15 (default for 7500) (Figure 2). The Ct can be affected by the starting template copy number and the efficiency of DNA amplification by the PCR system. There is an exact inverse mathematical relationship between starting copy number of target DNA and the resulting Ct. This is the basis for RT-PCR. The ABI 7500 RT-PCR instrument has an Auto-Ct option that allows the software to combine the results from the defined baseline and threshold settings to determine the Ct. The software then generates a standard curve of Ct versus starting copy number for all standards and then determines the starting copy number of unknowns by interpolation. The Ct and threshold can also be set manually (recommended 0.2).
Figure 2 Model of a single amplification plot showing terms commonly used in RT-PCR.

<table>
<thead>
<tr>
<th>Abv.</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rn</td>
<td>The fluorescence emission of the reporter dye divided by the fluorescence emission intensity of the passive reference dye.</td>
</tr>
<tr>
<td>Passive reference</td>
<td>A dye that provides an internal reference to which the reporter dye signal can be normalized during data analysis. Normalization is necessary to correct for forestallment fluctuations caused by changes in concentration or volume. A passive reference dye is included in all SDS PCR reagent kits.</td>
</tr>
<tr>
<td>Rn+</td>
<td>The Rn value of a reaction containing all components, including the template</td>
</tr>
<tr>
<td>Rn-</td>
<td>The Rn value of an un-reacted sample.</td>
</tr>
<tr>
<td>ΔRn</td>
<td>The magnitude of the signal generated by the given set of PCR conditions. The ΔRn value is determined by the following formula: (Rn+)-(Rn-).</td>
</tr>
<tr>
<td>NTC</td>
<td>(no template control) - A sample that does not contain template. It is used to verify amplification quality.</td>
</tr>
<tr>
<td>Standard</td>
<td>A sample of known concentration used to construct a standard curve. By running standards of varying concentrations, you create a standard curve from which you can extrapolate the quantity of an unknown sample.</td>
</tr>
<tr>
<td>Threshold</td>
<td>The average standard deviation of Rn for the early PCR cycles, multiplied by an adjustable factor. The threshold should be set in the region associated with an exponential growth of PCR product.</td>
</tr>
<tr>
<td>Unknown</td>
<td>A sample containing an unknown quantity of template. This is the sample whose quantity you want to determine.</td>
</tr>
</tbody>
</table>

Table 1 Abbreviations
Example of Real Time Amplification:

When using TaqMan probes the fluorescent signal (or normalized reporter, Rn) increases as the amount of specific amplified product increases. Figure 3 shows the amplification of PCR product in a plot of Rn vs. cycle number during PCR. This amplification plot contains three distinct phases that characterize the progression of the PCR.

The Quantifiler™ Human DNA Quantification Kit contains two independent sets of primers and TaqMan probes constituting two specific 5’ nuclease assays. Each set represents a “detector”. One detector is a target specific assay for human DNA (hTERT - human telomerase reverse transcriptase gene) and the second is an internal PCR control (IPC) assay (a synthetic sequence not found in nature). Both human and IPC detectors are designed to amplify in parallel in every reaction to act as internal controls that assess the quality of amplification. The internal PCR control (IPC) is designed to detect for the presence of inhibition due to either too much DNA or common PCR inhibitors. The IPC components consist of an IPC template DNA, two primers, and one VIC® dye-labeled probe. The target specific human assay components consist of two primers and a FAM™ dye-labeled Taqman MGB probe. Amplifying both assays in parallel allows the user to verify negative human DNA as well as the presence of inhibitors. Observation of positive signal (above threshold at Ct) for both assays would result in a confirmation of
amplification of human DNA with out inhibitors. Failure of the target specific human assay to achieve threshold at Ct, but positive IPC would indicate no inhibitors, but negative human DNA. Failure of both the target specific human assay and the IPC would indicate inhibitors. Alternately, if the IPC never accumulates fluorescence that exceeds the unused probe (usually around cycle 6) and the sample has a Ct value greater than the 50ng standard then the IPC failed due to too much DNA.

Because of the progressive cleavage of TaqMan fluorescent probes during the PCR, as the concentration of amplified product increases in a sample, so does the Rn value. For example, with the dilutions of RNase P target in the TaqMan® RNase P Instrument Verification Plate, the ratio of template concentration to detectable signal is preserved in the geometric phase for all dilutions (Figure 4). As the rate of amplification approaches a plateau, the amount of product is no longer proportional to the initial number of template copies.

![Figure 4 measurement at geometric phase](image)

Each cycle in the PCR reaction corresponds to a two-fold increase in product. Likewise, a difference in Ct values of 1 equates to a two-fold difference in initial template amount.
Reagent preparation:

**Human DNA Standards:**

Prepare Quantifiler Human DNA standards fresh daily using DDI H₂O (or TE buffer) and Table 1. Label the eight tubes 1 through 8, and date. Add the appropriate amount of DDI H₂O (or TE) to each tube and vortex to mix thoroughly. Transfer 5 μl of DNA to tube 1 and pipette up and down then vortex to mix thoroughly (at least 10 sec.). Remove 5 μl of DNA from tube 1 and transfer to tube 2 containing 10 μl DDI H₂O, vortex. Repeat until 5 μl DNA from tube 7 has been added to tube 8.

<table>
<thead>
<tr>
<th>Standard</th>
<th>Concentration (ng/μL)</th>
<th>Example Amounts (long term storage ≤ two (2) weeks)</th>
<th>Minimum Amounts</th>
<th>Dilution Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Std. 1</td>
<td>50.000</td>
<td>50 μL [200 ng/μL stock] + 150 μL T10E0.1/glycogen buffer</td>
<td>5 μL [200 ng/μL stock] + 15 μL DDI H₂O</td>
<td>4</td>
</tr>
<tr>
<td>Std. 2</td>
<td>16.700</td>
<td>50 μL [Std. 1] + 100 μL T10E0.1/glycogen buffer</td>
<td>5 μL [Std. 1] + 10 μL DDI H₂O</td>
<td>3</td>
</tr>
<tr>
<td>Std. 3</td>
<td>5.560</td>
<td>50 μL [Std. 2] + 100 μL T10E0.1/glycogen buffer</td>
<td>5 μL [Std. 2] + 10 μL DDI H₂O</td>
<td>3</td>
</tr>
<tr>
<td>Std. 4</td>
<td>1.850</td>
<td>50 μL [Std. 3] + 100 μL T10E0.1/glycogen buffer</td>
<td>5 μL [Std. 3] + 10 μL DDI H₂O</td>
<td>3</td>
</tr>
<tr>
<td>Std. 5</td>
<td>0.620</td>
<td>50 μL [Std. 4] + 100 μL T10E0.1/glycogen buffer</td>
<td>5 μL [Std. 4] + 10 μL DDI H₂O</td>
<td>3</td>
</tr>
<tr>
<td>Std. 6</td>
<td>0.210</td>
<td>50 μL [Std. 5] + 100 μL T10E0.1/glycogen buffer</td>
<td>5 μL [Std. 5] + 10 μL DDI H₂O</td>
<td>3</td>
</tr>
<tr>
<td>Std. 7</td>
<td>0.068</td>
<td>50 μL [Std. 6] + 100 μL T10E0.1/glycogen buffer</td>
<td>5 μL [Std. 6] + 10 μL DDI H₂O</td>
<td>3</td>
</tr>
<tr>
<td>Std. 8</td>
<td>0.023</td>
<td>50 μL [Std. 7] + 100 μL T10E0.1/glycogen buffer</td>
<td>5 μL [Std. 7] + 10 μL DDI H₂O</td>
<td>3</td>
</tr>
</tbody>
</table>

**Table 2 Standard dilutions**

**To prepare the reactions:**

Calculate the volume of each component needed to prepare the reactions, using the table below.

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantifiler Human Primer Mix</td>
<td>10.5 μl x ____ number of samples</td>
</tr>
<tr>
<td>Quantifiler PCR Reaction Mix</td>
<td>12.5 μl x ____ number of samples</td>
</tr>
</tbody>
</table>

**Table 3 Reaction Volumes**

**Note:** Include additional reactions in your calculations to provide excess volume for the loss that occurs during reagent transfers.
CHEMICAL HAZARD. Quantifiler PCR Reaction Mix may cause eye and skin irritation. Exposure may cause discomfort if swallowed or inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

Prepare the reagents:

Thaw the primer mix completely, then vortex 3 to 5 seconds and centrifuge briefly before opening the tube.

Swirl the Quantifiler PCR Reaction Mix gently before using. Do not vortex it.

Pipette the required volumes of components into an appropriately sized polypropylene tube.

Vortex the PCR mix 3 to 5 seconds, then centrifuge briefly. Dispense 23 µL of the PCR mix into each reaction well.

Add 2 µL of sample, standard, and reagent blank to the appropriate wells. For plate setup examples, (see page 14).

IMPORTANT! Applied Biosystems recommends running duplicates of the eight DNA quantification standards for each assay and on each reaction plate (see page 14).

Seal the reaction plate with the Optical Adhesive Cover.

Centrifuge the plate for about 20 seconds in a tabletop centrifuge (oxo salad spinner) with plate holders to remove any bubbles.

Note: If a tabletop centrifuge with 96-well plate adapters is not available, this step can be omitted.

Setting Up a Plate Document:

You can enter sample information into a new plate document, import sample information from an existing plate document or use a template to setup a new plate document. The section below describes setting a new plate document.

If the SDS software is not already started, select Start > Programs > ABI Prism 7500 > ABI Prism 7500 SDS Software.

In the SDS software, select File > New to open the New Document Wizard dialog box (figure 5).
In the Assay drop-down list of the New Document Wizard, select **Absolute Quantification (Standard Curve)**. Accept the default settings for container (96-Well Clear) and template (Blank Document).

Enter a name in the Default Plate Name field or accept the default.

To use an existing template select it in the **Template** drop down. (see below for saving a plate as a template). **Note** a template must be saved as a plate file (*.SDS) in order for the plate to be run.

Click **Next>** to select detector to apply to the plate document.
Before you set up the plate document, you need to create detectors in the SDS software for running Quantifiler kit assays (See Creating Detectors Appendix A). After the detectors are created, you do not need to create detectors for subsequent runs of Quantifiler kit assays.

Select the desired detector(s) (figure 6) and click the Add> button.

Select Quantifiler Human FAM and IPC VIC when using the Applied Biosystems Quantifiler™ Human DNA quantitation kit.

You need to apply detectors to the plate document for the wells on the reaction plate that contain DNA quantification Standards, or Unknowns (Non-template controls are not selected or used when using the Quantifiler Human assay). Repeat the procedure until you complete applying detector tasks, quantities, and sample names.

Specify the detectors and tasks for each well (figure 7).
Click on a well (or group of wells, for replicates) to select it.

Click on the detector name(s) to select the detector(s).

Click under the Task column to assign the detector task (Standard, or Unknown).
Enter a quantity for wells that contain standards. Normally 50, 16.7, 5.56, 1.85, 0.620, 0.210, 0.068, 0.023.

Click finish. The detector task and color are displayed in selected wells in the Plate document (see above).

Enter the sample names:

Click or select View> Well inspector (icon with small magnifying glass on it).

Click on a well or click and drag to select replicate wells.

Enter a sample name (figure 9).
The passive reference in the bottom right corner of the Well Inspector window should be defaulted to **ROX**.

**Important!** If your experiment does not use all the wells on the plate, **DO NOT** omit the wells from use at this point. Omitting the wells at this point will prohibit data from being collected in those wells. You can omit the wells after the run if necessary.

To change information after it is entered, double clicking on the well will reopen the well inspector. Click or select **View> Well inspector**.

Note: you can also change the sample setup information (sample name, detector, task) after the run is complete.

Verify the information on each well in the setup (figure 10).
Note: Standards do not have to be run antiparallel as illustrated above

Plate documents can either be saved as templates or plate documents.

In order to run a plate it must be saved as a plate document (*.SDS)

To save a plate as a template save the plate as a (*SDT) and save it in C:\Program files\7500 files\

Templates can be recalled in the Template drop down in the New Document Wizard (see above).

Amplification:

When plate setup is complete, Click on the Instrument tab to enter the program. The amplification program should appear as follows (figure 11):
The volume should be entered as **25 μl**

Check Box for **9600** (default)

While most templates should have stage one (the 50° hold) deleted, new templates may not. This stage should be deleted. While holding the shift key select **Stage 1** and delete it by hitting the delete key.
Figure 12 Amplification

The amplification window should appear as above. Click **Start**.
Interpretation:

After the run is complete the data must be analyzed. Click the green arrow (play button) to analyze.

Select the results tab. Selecting the results tab will grant access to several other tabs Plate, Spectra, Component, Amplification Plot, Standard Curve, Dissociation, and Report.

Select the Amplification Plot tab (Figure 13). Here you can observe your data to ensure the run has worked successfully. See Quantifiler Users Manual for troubleshooting.

On the plate document below the plot select all wells.

In the detectors drop down select all.

In the Data drop down Select Delta Rn Vs. CT.
It is recommended to set the threshold at 0.2 and the baseline is set to be between 3 and 15 cycles.

In the Detectors drop down list, select IPC. Typically, The Ct value for all of the IPC should be between 26 and 29 cycles. Ct Values outside of this range could indicate inhibition or too much DNA. See Quantifier uses manual for troubleshooting.

The threshold and baseline can be adjusted manually by manually entering values, or in the case of the threshold, dragging the bar. A red threshold bar would indicate that the data need to be analyzed. A green bar would indicate that the data has been analyzed; however, the recommended threshold is 0.2 and baseline 3-15.
The standard curve is a linear regression; therefore, the larger standards e.g. 50 ng/μl (lower Ct values) will be in the bottom right corner and the smaller standards 0.023 ng/μl will be in the upper left (higher Ct values).

Standards in the middle to upper concentrations (e.g. 0.62 – 16.7) are expected to fit the curve more tightly than standards in the lower concentration ranges, e.g. 0.023 ng/μl.

Select the standard curve tab (Figure 14). The standard curve slope should be between -2.9 to -3.3 (a slope of -3.32 indicates 100% amplification). The R² value should be greater than 0.98. In the report, Ct values for the standards should increase by approximately 1.5 cycles for every three-fold reduction in DNA concentration (i.e. standards are 3 fold dilutions).

If the standard curve slope does not comply with the above guidelines, data points can be eliminated by selecting Omit Well and reanalyzing. Although one should try to minimize the number of standards they omit, No more than 8 data points can be omitted.
About Standard Curve Results

The standard curve is a graph of the CT of quantification standard reactions plotted against the starting quantity of the standards. The software calculates the regression line by calculating the best fit with the quantification standard data points. The regression line formula (a variation of \( y = mx + b \)) has the form:

\[
CT = m \log(Qty) + b
\]

where \( m \) is the slope, \( b \) is the y-intercept, and Qty is the starting DNA quantity. The values associated with the regression analysis can be interpreted as follows:

Regression coefficients:

– **Slope**—Indicates the PCR amplification efficiency for the assay. A slope of \(-3.32\) indicates 100% amplification efficiency.
– **Y-intercept**—Indicates the expected CT value for a sample with Qty = 1 (for example, 1 ng/\( \mu \)L). A Y-intercept of 28.5 would be a theoretical Ct value of a sample with a concentration of 1 ng/\( \mu \)L.

\( R^2 \) value – Measure of the closeness of fit between the standard curve regression line and the individual CT data points of quantification standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points. An \( R^2 \) value \( \geq 0.99 \) indicates a close fit between the standard curve regression line and the individual CT data points of quantification standard reactions.

An \( R^2 \) value of <0.98 is unacceptable, check the following:

- Quantity values entered for quantification standards in the Well Inspector during plate document setup
- Making of serial dilutions of quantification standards
- Loading of reactions for quantification standards
- Failure of reactions containing quantification standards

Also refer to the troubleshooting section of the Quantifiler manual.

Select the **report tab** to view report (Figure 15).

**Important!** The quantity in the **QTY** column is predicated on the amount of DNA you indicated in your standards. For example, if you typed the first standard as 50 ng/\( \mu \)L, the resulting quantity will be interpreted as ng/\( \mu \)L.
Either the entire report can be printed or just selected wells. Results can also be exported to an excel workbook.

The Component Tab and Spectra tab can be used for troubleshooting. See Quantifiler Users manual.

After analysis, quantities will be displayed on the Plate view as well. This is just another way to view the data.

Any sample with a resulting Ct value of greater than or equal to 37 can be considered negative.

7.14 Required Reading:
Applied Biosystems Quantifiler Kits User’s Manual
DNA Section Procedure Manual

7.15 Amplification:

7.15.1 Background:
PCR is a method for the enzymatic synthesis of specific sites on the DNA strand, using primers that hybridize to the flanking region of the site of interest. The template DNA is first denatured by heating in the presence of a large molar excess of the primers and the four dNTPs. The reaction is then cooled to a temperature that allows the primers to anneal to their target sequences. The annealing primers then are extended by the enzyme Taq polymerase. The system continues an automated series of heating and cooling cycles. Because the synthesized DNA fragments can serve as a template in the next cycle, the number of target DNA fragments approximately doubles at every cycle. The final extension promotes the non-template nucleotide addition by Taq.

7.15.2 Quality Assurance/Quality Control:

7.15.2.1 Negative Control:
Negative control is made with each amplification and demonstrates that no exogenous DNA is present in the amplification reagents.

7.15.2.2 Positive Control:
Positive control (DNA 9947A) is used to demonstrate that the amplification worked properly.

7.15.3 Procedure: Refer to the DNA Section Procedure Manual for detailed instruction.

Components:

7.15.3.1 Taq DNA Polymerase:
Taq is an enzyme from a thermophilic eubacterial microorganism, Thermus aquaticus. Taq polymerase is relatively stable and is not denatured irreversibly by exposure to high temperatures. A number of forms of Taq polymerase are now available: the native enzyme purified form Thermus aquaticus and the genetically engineered forms of the enzyme synthesized in E. coli (AmpliTaq and AmpliTaq gold). Both forms of the polymerase carry a 5’ ----> 3’ exonuclease activity. The AmpliTaq gold is designed to be inactive enzymatically until it is heated to 95°C for a period of time, which then converts it into an active polymerase.

7.15.3.2 PCR Primers:
In order to amplify a sequence of DNA, primers flanking the target DNA sequence of interest are used. These primers, 15-30 bases, typically have different sequences and are complementary to sequences that lie on opposite strands of the template DNA with their 3’ ends oriented towards each other. The primers are responsible for the sequence specificity of the PCR reaction. Taq polymerase extends the repeat fragment starting at the bound primer. The primers are labeled with the NHS- ester dyes: 5-Fam (blue), Joe (green), and Ned (yellow).

7.15.3.3 Reaction Mixture:
The reaction mixture contains the necessary components for amplification to occur

7.15.3.3.1 Deoxynucleotides: dATP, dGTP, dCTP, and dTTP

MgCl₂: Binds to phosphate groups and reduces repulsive forces between dNTPs and template. Low amounts of Mg²⁺ decrease product and inhibit nucleotide addition, excess amounts increase unwanted products.
7.15.3.3.2 Bovine Serum Albumin: Stabilizing agent, minimizes the effects of inhibitors.

7.15.3.3.3 Sodium azide: a preservative

7.16 Required Reading:


DNA Section Procedure Manual

7.17 Capillary Electrophoresis:

7.17.1 Background:

Capillary electrophoresis allows for the rapid separation of DNA fragments that are labeled with fluorescent dyes, which when excited by a laser are detected by a Charged Couple Device (CCD) camera that converts the emission signal into an electronic signal. The software converts this signal to an electropherogram.

7.17.2 Quality Assurance/Quality Control:

7.17.2.1 Positive Control:

The positive control should yield a complete profile above minimum threshold, with the correct allelic designations at all loci for the kit and control used.

7.17.2.2 Negative Control:

The negative control should not yield any typeable alleles above minimum threshold.

7.17.2.3 Female Negative Control

The female negative control should not yield any typeable alleles above minimum threshold.

7.17.2.4 Reagent Blank

The reagent blank should not yield any typeable alleles above minimum threshold.

7.17.2.5 Overlapping Loci:

The overlapping loci between systems, Amelogenin, D3S1358 and D7S820 should coincide. This may not occur, though, with mixtures and weak samples. Success in one system and not the other does not preclude reporting loci types.

7.17.3 Second Review:
A qualified Criminalist will perform a technical review upon completion of the case and document his/her agreement by initialing the report of examinations.

7.17.4 Procedure: Refer to the DNA Section Procedure Manual

7.17.4.1 Sample Setup:

7.17.4.1.1 Heating/Snap Cooling:
Heating the samples at 95°C for 3-5 min forces the DNA strands to become single stranded. Snap cooling prevents the immediate reannealing of the strands.

7.17.4.1.2 Deionized Formamide is required for keeping the fragments single stranded for long periods of time.

**Warning:** Formamide is a mutagen. Wear gloves and do not inhale. Tubes containing formamide must not be autoclaved.

7.17.4.2 Instrumentation:

**Components:**

7.17.4.2.1 Capillary:
Samples are separated in a 47 cm fused silica capillary. The capillary has a high surface area-to-volume and therefore allows for the use of high voltage resulting in rapid, high resolution separation of DNA fragments. A small window allows for the excitation and detection of the fluorescent dyes.

The capillary should be changed before 250 injections or if degradation is noted, such as peak broadening or unexplained peaks. The autosampler must be calibrated with a new capillary. An abnormally high base line may indicate that the window needs to be cleaned. Clean the window regularly with ethanol.

7.17.4.2.2 Syringe:
A 1 mL syringe maintains the polymer for the run. The seals must be tight to maintain pressure in the system. Clean the syringe when needed, flush with clean polymer or rinse with distilled water and dry. Remove all bubbles after adding polymer.

7.17.4.2.3 Block:
The block should be cleaned regularly. Ensure the block is dry and free of dust before adding polymer. Remove all bubbles.

7.17.4.2.4 Probe:
Platinum probes at each end of the system causes the flow of current that carries the sample through the capillary. Ensure the cathode probe is not broken, severely bent or encrusted with salt. Clean with DDI water.

7.17.4.2.5 Ferrules:
Must be tightly sealed to maintain pressure in the block and prevent leaking.

7.17.4.2.6 Autosampler:
The autosampler is the mechanism for delivering samples to the capillary.

Reagents/solutions:

7.17.4.2.7 Buffer:
A 1X Genetic Analysis buffer with EDTA is used to optimize the electrophoresis.

7.17.4.2.8 Polymer:
The 4% Performance Optimized Polymer (POP-4) is a liquid matrix used to separate DNA fragments. Decomposition of the polymer will cause spiking. Polymer should be changed if not used for more than three days.

*Warning*: Polymer is a neurotoxin and is absorbed through the skin. See MSDS

7.17.4.2.9 Deionized, Distilled Water:
Water is injected between the buffer and sample to create an ion depleted zone which enhances sample injection. The water also rinses off excess salt.

Measurement Standards:

7.17.4.2.10 Internal Standard:
The internal marker is an artificial series of DNA fragments of known size, 35-500 bases, and is used to measure fragment sizes and adjust for electrophoretic
mobility variances within and between injections. The fragments are labeled with NHS-ester dye Rox (red). Two fragments on each end of the allelic range are necessary for sizing.

The internal standard is added to each sample, excluding the Matrix.

7.17.4.2.11 Allelic Ladder:

The allelic ladder is composed of STR fragments of major alleles and is used to assign allele designations. An allelic ladder is included in each run.

Software parameters:

7.17.4.2.12 Matrix:

The mathematical matrices correct for spectral overlay of the fluorescent emission data collected by the CCD Camera. A matrix file is specific for each instrument for a particular set of run conditions.

A new matrix will be run when instrument conditions change significantly.

7.17.4.2.13 Threshold:

Threshold establishes the minimum Relative Fluorescence Units (RFU) measured by the analysis program, Genescan. Noise on average is at approximately 30 RFU. The software will not go below 5 RFU and may be over loaded at very low thresholds.

Sample analysis should not be performed below 50 RFU. Samples between 50 and 150 RFU should be interpreted with caution.

7.17.4.2.14 Injection:

Electrokinetic injection with the assistance of the current moves sample from the sample tube into the capillary. The time (seconds) allows for control of the volume of sample taken into the capillary.

High ionic samples will inhibit injection of DNA fragments. Increasing injection time will increase sample amount. Resolution may decrease with high injection times. Injections times are limited to 1-10 seconds.

7.17.5 Data Interpretation:
7.17.5.1 Normal scan:
A scan of a sample will normally only contain one or two alleles at each locus. Normally the heterozygote alleles should be balanced (peak height within approximately 80% of each other). Overly weak or strong samples should be adjusted prior to interpretation. A scan, which does not meet this definition, may be a mixture.

7.17.5.2 Mixture:
Mixtures are indicated by the presence of extra peaks at several loci; peak imbalance and peaks at stutter positions that are greater in percent than typically observed. Masking may occur if two individuals share alleles. Mixtures may be labeled with peak height or peak area.

7.17.5.3 Nucleotide addition:
The true allele is known as the ‘n’ peak. Taq catalyzes the nontemplate addition of a nucleotide at the 3' end of a strand. The amplification parameters are designed to encourage this addition (n+1). The final extension step of amplification promotes the nucleotide addition. The ‘n+1’ peak is the analyzed peak.

Strong samples may demonstrate a ‘split peak’ due to poor nucleotide addition. This peak is one base pair less than the main peak. The sample may be soaked at 60°C for 45 min or diluted and reamplified to minimize poor nucleotide addition.

7.17.5.4 Stutter/Reverse Stutter:
Amplification of tetranucleotides typically produces a minor peak 4bp (stutter) shorter than the allele. Stutter is caused by the separation of the copying strand from the template before amplification of the fragment is completed. Taq will reattach itself to the template, but may be misaligned by one repeat unit. On highly concentrated samples, multiple stutter units and reverse stutter, one repeat greater, may be noted.

The stutter peak height is approximately within 15% of the height of the analyzed peak. Genotyper will filter most stutter. Off scale samples will have unnaturally high stutter and must be corrected for proper interpretation.

7.17.5.5 Pullup/bleed Through:
Strong spectral readings in one color may cause the incomplete spectral separation of the other colors by the Matrix. Pullup will not have an ‘n’ peak. Thorough review of Genescan data will confirm this occurrence.

Pullup/bleed through can be caused by over amplification. The color is so strong that the Matrix cannot completely subtract out the other overlapping dyes. A matrix which is not compatible with the present data can also cause pullup. Severe matrix failure may result in what
appears as a reverse scan, where the peaks are extending below the base line. Less sample or a new matrix may be necessary to correct this problem.

7.17.5.6 Artifacts:

Noise and electrical spikes.
Noise is the natural fluctuation of the baseline that is caused by the running of the instrument. Electrical spikes are the sudden electronic surges that result in narrow baseline increases, which would have minimal peak area.
On average noise will be approximately 30 RFU. Reinjection may be necessary for a “cleaner” scan.

Undesolved crystals:
Crystals will cause a spectral separation of the laser that is recognized by the CCD camera as a fluorescent emission. These peaks occur in more than one color within 3 scan data points in Genescan. Single and double peaks have been observed.
Reinjection or setting the sample up again may be necessary to correct this problem.

Undenatured DNA:
Incomplete denaturing conditions may result in atypical peak morphology or the formation of extra small undenatured DNA peaks associated with the main allele peak. Also an increase of back sloping of the peaks, trailing, may be present. Subsequent heating, snap cooling and reinjection should provide a better result.

Dye Aggregates: Aggregates of dye are a manufacturing contaminant associated with the amplification primer mixture and is specific for each lot. An atypical peak morphology occurs. Correction cannot be made at laboratory level.

7.17.5.7 Genetic anomalies:

Trisomy mutations:
Genetic abnormalities such as trisomy can lead to additional peaks at a locus. Trisomy is the translocation or duplication of a portion or all of a chromosome, which includes a primer binding site. Trisomy may result in a three peak pattern or one allele being approximately double in height of the second allele. Reamplification should be accomplished to confirm result.

Somatic mutations:
Somatic mutations are localized mutations in tissue. It results in different alleles types of different samples being detected at one locus. Hair has a high rate of somatic mutation. The mutation is commonly one repeat different from the original allele size.

Variants:
Alleles not recognized by Genotyper may be variants. Reamplify to confirm peak is a true variant. Base pair size is measured by Genescan.
Mutations at the primer binding site:
Mutations at the primer binding site may completely prevent amplification of that allele resulting in a homozygote profile or minimize the amplification of the allele resulting in peak imbalance. The complete loss of the allele (null allele) is only a concern when comparing two different systems. This condition, though, is rare.

7.17.5.8 Preferential Amplification:
Amplification of higher molecular weight alleles is less efficient than amplification of low molecular weight alleles. Heterozygote peaks should have peak heights within 20% of each other’s. Outliers have been observed. Weak samples may demonstrate allelic dropout due to preferential amplification. Degraded samples or the presence of inhibitors may prevent the amplification of larger loci. Diluting the sample may help with inhibitors. Overly strong samples will demonstrate a rapid decline in peak heights from the smallest to the largest alleles often losing the last loci of a system. Less sample should be amplified or injected.

7.17.5.9 Off Scale Data:
Overly strong samples will exceed the linear scale of the software. Peaks will appear truncated and may be greater than 4500 RFU after analysis. Viewing the raw data or run log will demonstrate whether the sample is off scale. Mixtures and stutter cannot be properly interpreted on these samples. Less sample should be amplified or injected.

7.17.6 Report Conclusion Examples:
Exclusion:
Mr. Suspect is not the source of the blood stain on the glass.

Mr. Suspect is eliminated as a source of the blood stain on the glass.

Match:
The DNA profile developed from the blood stain on the glass is consistent with Mr. Suspect.

Mixture:
The profile developed from the blood stain on the glass is consistent with a mixture of Mr. Suspect and Ms. Victim.

The profile developed from the blood stain on the glass is consistent with being a mixture. The major component of the mixture is consistent with the profile of Mr. Suspect.
Statistics:
This profile has an approximate frequency of 1 in 1,000 of the Caucasian population and 1 in 1,000 of the Black population.

Method:
DNA comparisons were performed using Promega’s PowerPlex 16 genetic loci system.

CODIS:
The profile developed from the stain on the glass was entered in the COmbined DNA Indexing System (CODIS) for periodic searches against the convicted felon database.

7.18 Required Reading:

Quality Assurance Standards for DNA Testing Laboratories, sections 9, 11, and 12.

ASCLD-LAB Manual, Standards 1.4.2.5 - 1.4.2.8.

Perkin-Elmer 310 genetic Analyzer Manual

Perkin-Elmer Profiler Plus and COfiler Manuals

Perkin-Elmer 310 Genetic Analyzer Tutorial Software


DNA Section STR Validation Manual, 1998/1999


DNA Section CE Troubleshooting Guide
8 Block VII. CODIS (COmbined DNA Index System)

8.1 Overview:
CODIS is a computer software program that operates local, state, and national databases of DNA profiles from convicted offenders, crime scene evidence, suspects, and missing persons. CODIS software enables state, local, and national law enforcement crime laboratories to compare DNA profiles electronically, thereby possibly linking serial crimes to each other and identifying suspects by matching DNA profiles from crime scenes with profiles from convicted offenders or suspects of other crimes.

The missing persons index consists of the unidentified persons index and the reference index. The unidentified persons index contains DNA profiles from recovered remains, such as bone, teeth, or hair. The reference index contains DNA profiles from related individuals of missing persons so that they can be periodically compared to the unidentified persons index.

CODIS uses three indices to generate investigative leads in an investigation for which biological evidence is recovered from a crime scene. The convicted offender index contains DNA profiles of individuals convicted of certain crimes. Each state has different “qualifying offenses” for which persons must submit a biological sample for inclusion in the DNA database. The suspect index contains DNA profiles of individuals that have been under investigation for crimes submitted to the lab. The forensic index contains DNA profiles obtained from crime scene evidence, such as semen, saliva, or blood believed to be from the perpetrator. CODIS uses computer software to automatically search across these indices for a potential match.

CODIS is implemented with three hierarchical levels - local, state, and national. The hierarchical design provides state and local laboratories with the flexibility to configure CODIS to meet their specific legislative and technical needs.

Local: Typically, the Local DNA Index System (LDIS) is installed at crime laboratories operated by police departments or sheriff’s offices. DNA profiles originated at the local level can be transmitted to the state and national levels.

State: Each state has a designated laboratory that operates the State DNA Index System (SDIS). In Missouri, the Missouri State Highway Patrol is the designated laboratory. SDIS allows local laboratories within that state to compare DNA profiles. It also functions as the channel for submitting profiles to the National DNA Index System.

National: The National DNA Index System (NDIS) is the highest level of the CODIS hierarchy and enables qualified state laboratories that are actively participating in CODIS to compare DNA profiles. NDIS is maintained by the FBI under the authority of the DNA Identification Act of 1994.
8.2 Guidelines for participation in CODIS:

All laboratories submitting profiles to the MSHP for CODIS will be required to be in compliance with the DNA Identification Act of 1994, the NDIS Standards for Acceptance of DNA Data, and the FBI Approved Quality Assurance Standards for Forensic Testing Laboratories. The DNA profiles in the CODIS database will only be used to search against crime scene DNA profiles analyzed in criminal laboratories or private laboratories contracted by a law enforcement agency meeting all requirements set forth by the MSHP Crime Laboratory and FBI.

8.3 Guidelines for CODIS usage:

DNA profiles in the CODIS database will provide law enforcement agencies a means of identifying potential suspects of a crime. Crime scene profiles will be generated in DNA labs throughout Missouri and the United States and searched against convicted offender profiles and other crime scene profiles, which may generate potential investigative leads. Any information produced from the database will be used for law enforcement purposes only.

8.3.1 Casework Samples:

At the request of the FBI, a laboratory will demonstrate the CODIS compatibility of its DNA profiles. These requests from CODIS will only arise when concerns about the reliability or compatibility of the DNA results obtained by the laboratory occur.

8.3.1.1 An analysis of all 13 required loci must be attempted for Forensic samples and Unidentified Human Remains. The minimum number of PCR loci required for search purposes at NDIS for forensic unknown samples is 10 of the 13 core loci, and 8 of the 13 core loci for Unidentified Human Remains and Deduced Missing Person samples as established by the NDIS Standards. The minimum number of PCR loci required for search purposes at SDIS for forensic unknown, unidentified human remain and deduced missing person samples is 5 of the 13 core loci.

8.3.1.2 Keyboard searches at SDIS of profiles generated at other labs may be performed upon receipt of a letter or fax formally requesting the search. This search will be performed at the discretion of the CODIS State Administrator. The NDIS Custodian initiates keyboard searches of NDIS. The requesting agency must prepare a letter formally requesting the search.

8.3.1.3 Only one profile pertaining to multiple samples of the same origin for a case will be submitted. DO NOT enter multiple entries of the same profile from the same case. One may submit a profile from each case relating to serial crimes.
8.3.1.4 A laboratory offering a DNA profile to CODIS that is derived from forensic evidence will only offer those alleles that are directly attributed to human alleles and to the putative perpetrator(s). Alleles derived from forensic profiles that are unambiguously attributed to a victim or individual other than the perpetrator(s), such as, but not limited to a husband or boyfriend, will not be offered to CODIS.

8.3.1.5 The DNA results from any locus, in which an ambiguity exists in the assignment of one or more alleles to the perpetrator(s), can be offered to CODIS. The mere observation of alleles that may be attributed to individuals other than the putative perpetrator, does not in itself, preclude offering results to CODIS at the locus.

8.3.1.6 Forensic mixture DNA profiles submitted to NDIS shall have no more than four alleles at a maximum of four loci.

8.3.2 Convicted Offender Samples:

8.3.2.1 Biological samples from individuals meeting criteria established in RSMo 650 will have a DNA sample collected by employees of the MSHP Laboratory or those directed by employees of the laboratory.

8.3.2.2 Samples and information concerning the convicted offender will be stored for an indefinite period of time at the MSHP Laboratory unless instructed otherwise by a court order, i.e. expungement order.

8.3.2.3 Samples collected from convicted offenders are for database use only. No convicted offender sample will serve as the known standard in current or follow up criminal investigations. Upon a match to an offender, the law enforcement agency will be requested by the crime laboratory to obtain a new sample from the individual in question.

8.3.2.4 An STR profile for a convicted offender sample requires the complete 13 core loci profile as established by the NDIS Standards.

8.3.2.5 DNA profiles generated from each convicted offender will be stored in the FBI’s CODIS program.

8.3.3 Suspect Samples:

8.3.3.1 DNA profiles from adult individuals under investigation for crimes processed at the MSHP Laboratory will be entered into the Suspect Index. Profiles from juvenile suspects will not be entered into the database.

8.3.3.2 Information concerning the suspect will be stored with the case file of the case listing the individual as a Suspect. Selected identifying
information will be stored in a separate database for retrieval when a hit is made.

8.3.3.3 Upon a match to a Suspect, the law enforcement agency will be requested by the crime laboratory to obtain a new sample from the individual in question.

8.3.3.4 An STR profile for a Suspect sample requires the complete 13 core loci profile as established by the SDIS Standards.

8.3.3.5 DNA profiles generated from each Suspect will be stored in the FBI’s CODIS program at the State level.

8.4 Procedure for entering profiles into CODIS

8.4.1 Access the STR Data Entry program from the CODIS Programs folder.

8.4.2 Enter the specimen ID number using the proper format. The specimen ID number is generated as follows:

8.4.2.1 Print the laboratory case number of the sample, eliminating the hyphen after the “L”. (ex. - L202556)

8.4.2.2 Add the item number for the specimen immediately after the lab number with no spaces or symbols. (ex. - L2025561A)

8.4.3 Enter the correct specimen category. It is extremely important for maintenance of the database to have the correct specimen category.

8.4.4 Enter Yes or No in the “Source Identified?” box. If the profile has matched one of the reference standards from this case or another, the source has been identified for CODIS purposes.

8.4.5 Enter Yes or No in the “Partial Profile?” box. Any profile with at least one locus that is uninterpretable is considered a partial profile for CODIS purposes.

8.4.6 Enter any unusual or helpful information in the comments section. Names of individuals should not be entered into the comments.

8.4.7 List the alleles locus by locus in the “Reading #1” column. The complete profile should be entered into the “Reading #1” column before proceeding to the “Reading #2” column. Loci are listed in printed order of the PowerPlex 16 STR kits.

8.4.8 List the alleles locus by locus in the “Reading #2” column. The software will flag any discrepancies between the “Reading #1” and “Reading #2” columns automatically. If a discrepancy occurs, carefully review the case information for the correct type.
8.4.9 When the alleles have all been entered correctly, hit the “Save” button to enter the entire profile into CODIS.

8.4.10 Print a copy of the profile entered by hitting the “Print” button. The copy will be used by the Technical Reviewer of the case to check for correctness of the profile entered. Since an electronic copy of the profile is saved in CODIS the printed hard copy can be discarded.

8.5 Policy for entering Missing Persons cases

8.5.1 CODIS allows entry of profiles from missing person cases into three distinct indices:

8.5.1.1 The Missing Person Index consists of DNA profiles from missing persons and deduced victim knowns.

8.5.1.2 The Relatives of Missing Person Index contains profiles from biological relatives of individuals reported missing.

8.5.1.3 The Unidentified Human (Remains) Index contains profiles from living persons who can not or refuse to identify themselves, and recovered dead persons whose identities are not known.

8.5.2 The following guidelines cover procedures for the entry of DNA profiles into CODIS:

8.5.2.1 The submitting agency will complete a “Laboratory Analysis Request Form, SHP-411” for all cases submitted to the Laboratory. The SHP-411 will provide essential information about how each piece of evidence relates to the individuals involved. The Laboratory will use this information to properly determine what analyses are needed and interpret the results.

8.5.2.2 Body fluid stained evidence should be completely air dried before packaging in paper containers (paper bags, boxes, or envelopes). If this is not possible due to the nature of the sample (tissue from an autopsy) the sample must be frozen to preserve it in its current state. Where possible, more than the minimum amount of material should be provided for analysis. Care should be taken to protect the sample from extreme heat for extended periods (i.e. the interior of a car in summer).

8.5.2.3 Before profiles are eligible for entry into CODIS, a missing person report must be entered into National Crime Information Center (NCIC) by the law enforcement agency in charge of the investigation. Profiles entered into any of the three indices in CODIS will reference the unique NIC number of the appropriate NCIC report.
8.5.2.4 When obtaining comparison standards from relatives of missing persons a Consent and Information Form must be filled out and signed by the donor. The completed form should be forwarded to the State CODIS Administrator. Whole blood or buccal (oral) swabs are preferred for reference standards.

8.5.2.4.1 Whole blood standards should be collected by medical personnel in vacutainer tubes containing the anticoagulant EDTA (purple capped tubes). Grey or red-capped blood tubes are undesirable for DNA analysis. If there is any delay in the submission of these standards to the laboratory, this blood should be refrigerated but not frozen.

8.5.2.4.2 When submitting buccal swabs, collect the cells onto the swab by placing the swab against the interior of the individual’s cheek and rubbing back and forth for 20 to 30 seconds (collection should not be painful and is less invasive than drawing blood). Once the sample has been collected it should be air dried, placed back into its original packaging, placed into an envelope, sealed, initialed, and submitted to the laboratory in a timely manner.

8.5.2.5 Once samples are analyzed and profiles are entered into the appropriate index, the CODIS Administrator will produce a letter to the submitting agency and NDIS Custodian detailing analysis results. In order to finalize the letter, the casework Criminalist must notify the CODIS Administrator of the name and address of the investigating officer and the Submitting Agency. Included in the letter will be the following information that must be entered into the miscellaneous field of the NCIC report by the submitting agency:

8.5.2.5.1 The ORI number assigned to the MSHP Crime Laboratory.

8.5.2.5.2 The CODIS specimen ID number.

8.5.2.5.3 The specimen category assigned to the sample(s) analyzed.

8.5.2.5.4 The type of DNA analysis performed.

8.5.2.5.5 The CODIS Administrator will forward a copy of the letter to the casework Criminalist for entry into the case file.
8.5.2.6 Evidence previously subjected to DNA analysis by another laboratory or expert will not be examined by the MSHP Laboratory unless directed by the Court.

8.6 Policy for entering Suspect profiles

8.6.1 Missouri CODIS allows entry of profiles of known suspects. Specimens assigned to this category will be entered into the Suspect Index. The suspect index shall be searched against Forensic Unknown Index, Unidentified Human Remain Index and the Missing Person Index.

8.6.1.1 Suspect - An individual whose identity is known to the police and who is alleged to be the perpetrator of a crime.

8.6.2 The following guidelines cover procedures for the entry of DNA profiles into Missouri CODIS:

8.6.2.1 For purposes of this database it will be assumed that samples collected and submitted by an agency will have been legally obtained.

8.6.2.2 Acceptable samples for the Suspect database are as follows:

8.6.2.2.1 Whole blood standards - These samples should be collected by medical personnel in vacutainer tubes containing the anticoagulant EDTA (purple capped tubes). Grey or red-capped blood tubes are undesirable for DNA analysis.

8.6.2.2.2 Buccal swabs - Buccal swabs are an acceptable alternative to whole blood standards. Commercially available swabs specifically designed to collect cheek cells are preferred. In the absence of these swabs, a sterile examination swab may be submitted. The analyst will determine acceptance of any other method of collection.

8.6.2.2.3 Hair standard - This is the least desirable of the three acceptable methods. A proper hair standard consists of hair that has been physically pulled from the body of the individual and that has an active root area and sheath. The root area and sheath contain the nuclear DNA necessary for an STR analysis. The hair sample must be pulled to ensure that the hair did in fact come from that individual.

8.6.2.3 Unacceptable samples for the Suspect database are:
8.6.2.3.1 Secondary standards - Profiles generated from cigarette butts, aluminum cans, cups, or discarded items of any sort are considered secondary standards. This list is not all-inclusive. If there is any question of inclusion of a profile into the Suspect database, that decision shall be made by the analyst and/or CODIS Administrator.

8.6.2.3.2 Elimination samples - Profiles generated from individuals somehow associated with a crime, but not suspected of committing the crime.

8.6.2.3.3 Relative samples - The known reference samples voluntarily provided by biological relatives of missing persons.

8.6.2.4 Once samples are analyzed the profiles will be entered into the appropriate index.

8.6.2.4.1 A complete 13 core loci profile, as established by the SDIS Standards, is preferred for the suspect’s STR profile. The State CODIS Administrator at his/her discretion may accept profiles consisting of less than the 13 core loci.

8.6.2.5 Notification of Match Verification

8.6.2.5.1 Once a suspect’s sample is verified, the State CODIS Administrator will advise the casework analyst or Local CODIS Administrator. The local law enforcement agency will be notified via the local crime laboratory responsible for the crime scene sample. If several agencies are involved, all jurisdictions will be notified allowing for the dissemination of information between all concerned. Notification will be documented with the use of the Match Data Request form. Case specific/investigative information will not be released by the MSHP without permission from the responsible agency.

8.6.2.5.2 Upon a match to a suspect, the law enforcement agency will be requested by the crime laboratory to obtain a new sample from the individual in question.

8.6.2.6 Sources of expungement requests may be received as follows:

8.6.2.6.1 In the form of a court order. If the MSHP Crime Laboratory receives a court order directing expungement,
the MO CODIS Administrator/Designated State Official shall delete the record using the CODIS software.

8.6.2.6.2 In the form of a letter from the Missouri Department of Corrections, MSHP legal staff, or the Missouri Attorney General’s Office.

8.6.2.6.3 A written expungement request received from any other party shall be referred to MSHP legal staff and no action will be taken until instruction is received from MSHP legal staff.

Note: Any concerns or questions about the validity of an expungement request should also be referred to MSHP legal staff.

8.6.3 Expungement Procedure:

8.6.3.1 Verification of the suspect’s identity.

8.6.3.1.1 A check of the information on the submitting request for expungement will be made against the suspect information on file.

8.6.3.2 The pertinent entries on the Suspect Expungement form will be completed.

8.6.3.3 The suspect’s identifier is removed from the suspect database and witnessed. Document the date of expungement in the suspect database and the reason for the expungement. All other information in the suspect database will remain.

Note: When a duplicate profile is obtained from an individual, the new profile should not be entered into the database.

8.6.3.4 The specimen will be deleted from the MSHP CODIS server.

8.6.3.5 If expungement occurs after DNA analysis, the CODIS database entry referencing the expunged sample will be expunged. The CODIS deletion will be witnessed and documented on the Suspect Expungement form. Only individuals with administrative privileges in CODIS will be allowed to delete specimens.

8.6.3.5.1 Upon completion of all appropriate steps, if necessary, a letter will be generated to the requesting agency documenting the expungement request.

8.6.3.6 Combine the deleted CODIS record reports and/or written notification for removal, and the expungement form and file.
8.6.3.7 If an expunged individual has been involved in prior matches and if those cases have been removed from the Casework Index they will be re-included. Match information can be verified by querying the Match Manager. (See CODIS Manuals). If a DNA profile that is a candidate match is to be expunged, the other State’s convicted offender or casework laboratory will be informed that an expungement is being performed.

Note: Any identification, warrant, or probable cause to arrest based upon a database match is not invalidated due to a failure to expunge or a delay on expunging records.

8.7 CODIS match

8.7.1 Correspondence

8.7.1.1 CODIS State Match Result Report - generated automatically by CODIS, sent to appropriate laboratories via DNACOMM whose profile(s) are associated to another profile.

8.7.1.2 CODIS DNA Match Data Request/Hit forms - will be used to minimize paperwork between labs and standardize the information transferred. The purposes of the request form is to notify the associated laboratory of a possible match to a profile originating from their lab and to connect all law enforcement agencies involved so they can further their investigations with the new lead(s).

8.7.2 Laboratory Match Response

8.7.2.1 Upon receipt of correspondence from another laboratory referencing a potential match, the lab receiving the request will have 30 working days to follow their standard operating procedures to verify the possible match and return the completed form to the submitting lab.

8.7.2.2 The request form may be faxed or mailed with the laboratory agency identified somewhere in the letterhead (fax coversheet or agency stationary).

8.7.2.3 Laboratories with samples that are verified as matches will forward this information on to the local law enforcement agency(s), who submitted the original evidence sample(s), so all law enforcement agencies involved can communicate with one another.

8.7.2.4 Match dispositions will be entered into CODIS Local/State Match Manager as soon as available. Disposition information will then be submitted to Match Manager at SDIS/NDIS.
8.7.2.5 NDIS match dispositions where samples do not require replication of analysis may be handled via the telephone with the other laboratory involved in the match. Disposition of the information will be noted in Match Manager.

8.8 Required Reading


FBI Laboratory. NDIS Standards For Acceptance of DNA Data.

MSHP Crime Lab (DNA Profiling Section). MO CODIS Operation Procedures.


Current Missouri Database Law
9 Block VII. Legal Aspects of Evidence:

9.1 Chain of Custody:

The chain of custody is necessary to ensure that the integrity of the evidence is maintained. The chain of custody covers the total period of time between when the evidence is collected and completion of the court proceedings.

Criminalists/Technician must be familiar with the procedures for receiving, labeling and sealing evidence as stated in the Laboratory Operations Manual. Documentation of the chain of custody requires complete descriptions of the condition of evidence as it enters the lab, including proper sealing. Descriptions of evidence are kept in the case notes and are discoverable. Internal tracking of the evidence between lockers and Criminalists is necessary to track the conditions and analysis the evidence is subjected to while under the possession of the laboratory. Complete records of any evidence transfer should be created and kept in the case file.

9.2 Discovery:

Discovery of records allows the defendant access to all evidence in a case. For the purposes of the laboratory, this includes any documentation produced during the course of examinations and evidence transfers on any particular case. This material usually exists in the case file. Other lab documentation including, but not limited to, QA/QC manual and records, Protocols, Validations, Proficiency cover sheets, and instrument calibration records may also be discoverable. The lab policy is to make these records available to the defense team. In the interest of time and efficiency, a procedure has been developed to allow the defense team access to these records without undue disruption to laboratory activities. The procedure is outlined in the “Discovery Response” letter available in the genforms directory of the lab’s Y:\drive.

9.3 Deposition:

A deposition is the taking of testimony under oath, but not in court. A defense attorney will set up a deposition at a time and place that is convenient to the defense, prosecution, and Criminalist. A court reporter will be present to record the proceedings.

There is no judge present to rule on the legality of any questions asked. For this reason the Criminalist should be on guard to keep the questions focused on the work performed by the lab and not on personal issues. Because of the technical nature of the testimony, the witness should not waive signature at the end of the deposition. This allows the witness to check the testimony for accurateness before trial.

9.4 Subpoena:

A subpoena is a legal document requiring the appearance of an individual and/or documentation to give testimony at a hearing, deposition, or in a court case. Normally subpoenas are issued for the total expected duration of the trial or proceeding. In the interest of efficiency and time the Criminalist should contact the issuer of the subpoena to coordinate the actual time the testimony is needed.
Occasionally a Criminalist will be unavailable for testimony. In those circumstances a Supervisor or co-worker may be able to testify to the Criminalist’s notes and results in the case.

9.5 Evidence Admissibility:

9.5.1 Frye vs United States (1923):
Supreme court decision determined the rules of acceptance of scientific evidence. The Frye hearing should demonstrate the general acceptance of the procedure in the scientific community and the reliability of the results.

9.5.2 Daubert vs Dow:
This decision resulted in a more stringent examination of scientific evidence. It principally focuses on scientific methodology and procedure, peer review and error rate.

9.5.3 Voir Dire:
A preliminary examination concerning the competence of a witness or juror. Used to determine the qualifications of an expert witness.

9.6 Required Reading:
ASCLD-LAB Manual, section 1.4.2.18
Quality Assurance Standards for DNA Testing Laboratories, Standard 12.2
MSHP Discovery Response letter (Y:/genforms/Discovery response)
Laboratory QA/QC Manual, section 12
10 Trainee Checklist:

Upon completion of training, the Trainee should have knowledge and/or be able to perform the tasks listed below. The "Areas of Exploration" are suggested studies for the trainee to explore the limitations of each system and gain more experience in evidence analysis. Each Trainee should perform a small study involving a presumptive test, a confirmation test and DNA analysis.

General Knowledge:
Safety and Emergency Policy:
- ________ Escape routes and tornado procedures
- ________ Location of fire extinguishers, showers, fire blankets and spill kits
- ________ Optional Hepatitis B Vaccine
- ________ Accessibility of safety glasses, gloves and lab coats
- ________ Laboratory Safety Manual
- ________ Location of fire alarm
- ________ MSDS

Organization and Goals:
- ________ MSHP Goals and Objectives
- ________ Lab Goals and Objectives
- ________ MSHP Organization
- ________ CLD Organization
- ________ Laboratory Director
- ________ Assistant Director
- ________ QA Manager
- ________ Safety Officer
- ________ DNA Technical Leader
- ________ Immediate Supervisor
- ________ American Society of Crime Lab Directors (ASCLD)
- ________ DNA Advisory Board (DAB)
- ________ Scientific Working Group of DNA Analysis Methods (SWGDAM)
- ________ Midwestern Association of Forensic Scientists (MAFS)
American Academy of Forensic Science (AAFS)

**Required Paperwork:**
- Weekly timesheet
- Expense Account
- Court Attendance Record
- Court Observation Form
- Request for Leave
- Phone Log

**Physical Set-up:**

**Laboratory:**
- Supply and Store rooms
- Reagent/Chemical Cabinets
- Laboratory Records and Case File area
- Evidence storage areas
- DNA Profiling

**General Headquarters Complex:**
- Supply
- Budget and Procurement
- Headquarter Conference room
- Troop F

**Security:**
- Laboratory entry card and key
- Security system
- Information dissemination
- Evidence Security
- Refrigerator/Freezers
Office Equipment:

- ________ Phone
- ________ Computer
- ________ Digital camera
- ________ Copy Machine
- ________ Printers
- ________ Fax Machine

Laboratory Records & Evidence Control Clerk

Organization:

- ________ LRECC Supervisor

Who is responsible for:

- ________ Working the front counter
- ________ Answering the phone
- ________ Time sheets
- ________ Ordering, Invoices, and Vendor information
- ________ Archiving of case files
- ________ Certified Mail
- ________ Evidence inventory

Documentation:

- ________ Logging incoming evidence and case information at the front counter
- ________ Logging evidence coming in from Satellite labs
- ________ Procedures for returning evidence (Property Transfers)
- ________ Case filing
- ________ Archiving and retrieving case files from Archives
- ________ Visitor Log Book

Communications:

- ________ Handling incoming phone calls
- ________ Using the intercom
- ________ Using the Fax machine
Lab Supplies:
- Supply locations
- Supply availability
- Ordering office supplies

DNA Section:
General knowledge:
- Organization

Contamination Prevention Measures:
- Reason for preventative measures
- Decontamination procedures
- Evidence
- Amplification room
- Hoods
- Equipment

Section specific safety measures:
- Biohazard
- Sharps
- Biological fluids
- Chemical hazards
- Autoclave
- Disposal

Reagents/solutions:
- Preparation
- Storage
- Labeling
- Cleaning equipment and area
- Molecular grade chemicals
- Expiration dates
Logging

Equipment Maintenance:
- Temperature Checks
- Calibration Checks
- Cleaning
- Logging maintenance

Supplies:
- Ordering supplies
- Receiving supplies
- Storing supplies

Chain of Custody:
- Definition
- Significance
- Retrieving evidence from the locker
- Evidence storage
- Post exam evidence storage

Required Reading:

General Orders:
- Leave 22-05
- Dress and Appearance of Civilian Employees 26-04
- Sexual Harassment 26-06
- Civilian Employee Evaluations 35-03
- Travel and Miscellaneous Expenses 17-07
- Public Information and Media Relations 54-01
- Technician Manual
- Laboratory Safety Manual
- Laboratory Operations Manual

Examination for Blocks I and II: MSHP/Laboratory Familiarization
Stain Identification

Blood Detection:

Leuco Malachite Green:
- Preparation
- Quality Control
- Performing test
- Reaction
- Interpreting results
- Documenting results
- 100 Samples, may include samples for study

Areas of exploration
- False positives
- Sensitivity
- Effects of chemicals
- Effects of environment

Takayama:
- Use of the microscope
- Quality control
- Performing test
- Reaction
- Interpreting results
- Document results
- 100 Samples, may include samples for study

Areas of exploration
- False positives
- Sensitivity
- Effects of chemicals
- Effects of environment

Ouchterlony:
- Preparation
Quality control
Performing test
Reaction
Interpreting results
Document results
100 Samples, may include samples for study

Areas of exploration:
- False positives
- Sensitivity
- Effects of chemicals
- Effects of environment

Blood Detection Study

Semen Detection

Acid Phosphatase Spray:
Preparation
Quality control
Performing test
Reaction
Interpreting results
Document results
100 Samples, may include samples for study

Areas of exploration
- False positives
- Sensitivity
- Effects of chemicals
- Effects of environment

Alternate Light Source
Operating ALS

Revised: 07/06   Training -10-7   Y:/DNA/Manuals/DNA Training Manual
Quality control
Performing examination
Interpreting results
Document results

Areas of exploration:
- Fluorescence of common household products
- Sensitivity
- Effectiveness of other wavelengths
- Quenching by different substrates

ABAcard p30:
Quality control
Performing test
Reaction
Interpreting results
Document results
100 Samples, may include samples for study

Areas of exploration:
- False positives
- Sensitivity
- False negatives
- Effects of chemicals
- Effects of environment

Identifying Intact Sperm Cells:
Use of the microscope
Sperm morphology
Quality control
Document results

Semen Detection Study
Examination for Blocks III - V: Stain Identification Examination

Stain Identification Competency Test

Moot court for Stain Identification
DNA Analyst Training

Extraction: 

200 total extractions:

* 50 Blood stains to include standards for low level, semen and hair sample comparisons
* 50 Buccal samples to include standards for low level, semen and hair sample comparisons
  * Collected with CEP swabs and cotton swabs
* 50 Low level DNA samples to include samples that mimic casework such as:
  Bottles, cans, cigarette butts, clothing, blood, etc.
* 30 Semen containing samples to include:
  Various substrates and various times from incident
* 20 Hair samples

Suggested Areas of Exploration:

* Varying sample size or amount.
* Environmental effects, such as UV
* Chemical effects

Quantification:

* _________ Quantification theory
* _________ Quantification procedure
* _________ Quantification troubleshooting
* _________ Trainee will quantify all samples extracted

Amplification:

* _________ Trainee will amplify all DNA containing samples and the Reagent Blank
* _________ Amplification theory
* _________ Amplification procedure
* _________ Amplification troubleshooting

Suggested Areas of Exploration:

* Induce mixtures at different concentrations
* Amplification of samples without extension step
Sample Prep. for CE Analysis:

- Trainee will prepare all samples amplified for CE analysis.
- Setup procedure
- Setup troubleshooting

Suggested Areas of Exploration:

- Varying the amounts of ILS
- Effects of the absence of the denaturation/snap cooling step
- Varying the amounts of DNA

Instrumentation:

Trainee may explore some variances in the instrumentation but must be careful not to cause harm to employees or damage instrument. No instrument alterations may be attempted that may affect casework samples.

- CE operation
- CE theory
- Troubleshooting

Suggested Areas of Exploration:

- Variation of the buffer concentration
- Variation of the capillary alignment with the cathode probe
- Extended capillary usage
- Variation of the injection time

Genescan/Genotyper Analysis:

- Software operation
- Software theory
- Software Trouble shooting

Suggested Areas of Exploration:

- Effects of a bad matrix
- Effects of mislabeling GS500
- Effects of altering parameters, e.g. Smoothing, threshold and ranges

Interpretation:

- Identification of artifacts
- Identification of stutter
Identification of mixture
Mixture interpretation
Identification of single source samples

Suggested Areas of Exploration:
- Interpretation of Off-Scale data
- Interpretation of degraded data
- Interpretation of mixtures
- Measurement of stutter percentages
- Measurement of heterozygosity percentages

DNA Competency test

CODIS
- Structure of the CODIS System
- NDIS
- SDIS
- LDIS
- Samples eligible for CODIS
- Forensic Index
- Missing Person, Unidentified Human Remains Indices
- Suspect Index
- Search Procedures
- Hit procedures

Discovery:
- Discovery request
- Response to discovery
- Dissemination report
Legal Issues:

- ________ Frye vs United States (1923)
- ________ Daubert vs Merrell Dow Pharmaceuticals (1993)
- ________ Subpoenas
- ________ Court testimony
- ________ Court demeanor
- ________ Court attire
- ________ Court observation

 Examination for Block VI-VIII: DNA Analysis, CODIS, Legal issues

 Moot court for DNA Analysis
11 Technical Reading Checklist

Introduction

- ASCLD-LAB Manual, Sections 1.4.3, and 2.5
- Quality Assurance Standards for Forensic DNA Labs, Sections 5, and 13
- Laboratory QA/QC Manual, Sections 23, 24
- Lab Operations Manual, Tabs D and H
- Laboratory QA/QC Manual, sections 1, 5, 16, 17, and 18
- Laboratory Safety Manual
- ASCLD-LAB Manual, Section 1.3.3, 3.3, and 3.4.

Reagents & Preparation

- Laboratory QA/QC Manual, sections 13, 14, and 15
- DNA Evidence Technician Manual
- ASCLD-LAB Manual, sections 1.4.2.8 to 1.4.2.13 and associated discussion
- Quality Assurance Standards for Forensic DNA Laboratories, standards 9.2, 16.1
Evidence Examination

- Forensic Evidence Handbook, section III. 5.
- ASCLD-LAB Manual, section 1.4.1
- Quality Assurance Standards for Forensic DNA Laboratories, section 7
- Laboratory QA/QC Manual, sections 6 and 7
- Laboratory Operations Manual, tabs E, F, J, K, and L

Blood Detection

- Laboratory QAQC Manual, sections 8, 9, 10, 11, 12, and 19
Semen Detection

- Gaensslen, R.E., *Sourcebook in Forensic Serology, Immunology and Biochemistry*, National Institute of Justice, 1983, sections 10.3.1 to 10.3.5.


Revised: 07/06 Training -11-3 Y:/DNA/Manuals/DNA Training Manual
DNA Analysis


- Laboratory QA/QC Manual, section 16.

- ASCLD-LAB Manual, sections 3.1, 3.2.


- DNA Section Procedure Manual


- DNA Section Procedure Manual

- Quality Assurance Standards for DNA Testing Laboratories, sections 9, 11, and 12.

- ASCLD-LAB Manual, Standards 1.4.2.5 - 1.4.2.8.

- Perkin-Elmer 310 genetic Analyzer Manual

- Perkin-Elmer Profiler Plus and COfiler Manuals

- Perkin-Elmer 310 Genetic Analyzer Tutorial Software


- DNA Section STR Validation Manual, 1998/1999


- DNA Section CE Troubleshooting Guide

**CODIS**


- FBI Laboratory. NDIS Standards For Acceptance of DNA Data.

- MSHP Crime Lab (DNA Profiling Section). MO CODIS Operation Procedures.

Legal

- ASCLD-LAB Manual, section 1.4.2.18
- Quality Assurance Standards for DNA Testing Laboratories, Standard 12.2
- Laboratory QA/QC Manual, section 12
Creating Detectors:

Select **Tools > Detector Manager**.

In the lower left part of the Detector Manager dialog box, select **File > New** to open the New Detector dialog box.

When the dialog window opens enter the following:

- **Name:** Enter *Quantifiler Human*
- **Reporter Dye:** Enter *FAM*
- **Quencher Dye:** Make sure *(none)* is selected
- **Color:** Select the *Blue color*

Click **Create Another** to add the Quantifiler Human detector and to reset the New Detector dialog box.
Create a detector for the IPC assay:

In the SDS software, select **Tools > Detector Manager**. If the detectors for the Quantifiler kits have been created, they are listed in the Detector Manager window.